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PART 1: ON1 NONOISE Al OVERVIEW

ON1 NoNoise Al 2024 (charles

Noise & Sharpening

NoNoise Al Tack Sharp Al Both

ON1 NoNoise Al 2024 is an application and plugin that intelligently applies noise reduction and sharpening
to your images. NoNoise leverages ON1’s state-of-art, Al-based machine learning to remove luminance

and color noise from photos, while still maintaining fine details. NoNoise is designed to be applied at the
beginning of your editing workflow, and has been optimized for raw photos, supporting the raw file formats
from more than 800 cameras released in the past 20 years.

NoNoise processes raw photos using ON1's raw engine, demosaicing each image from its raw data; it then
determines the correct amount of noise reduction for your photo. You can set the general level of noise
you like to apply — low, medium or high — and NoNoise Al will apply that baseline with every image you
process, while still giving you full control to adjust the noise-reduction settings for each photo as desired.

Because noise reduction and sharpening go hand-in-hand, NoNoise includes ON1'’s exclusive progressive
sharpening algorithm, which enhances sharpness based on the size of the details in the photo, without

the halos and artifacts that other sharpening techniques can create. And, with ON1’'s new TackSharp Al
technology, enhanced sharpening and deblurring is now part of NoNoise Al, making the app/plugin your
single solution for removing noise and sharpening photos at the same time. TackSharp can detect and
remove motion blur as well as save out-of-focus shots, making it an indispensable tool in your photo arsenal.

When you're done processing images in NoNoise Al, you can export them as industry-standard DNGs to
preserve the complete color and tonal range of the original raw files, or you can save them in PSD, JPG,
PNG and TIF formats.

NoNoise is designed to be a adjunct to your existing workflow. It can run as a standalone app, where you
can process photos individually or in groups, and save them as processed DNGs for importing into your
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editing app. You can also run NoNoise as plugin for Adobe Photoshop, Lightroom Classic, Photoshop
Elements, Capture One, Affinity Photo, Corel Paint Shop Pro, or Apple Photos. And, when used with
Lightroom or Capture One, you can batch process multiple images directly from the app.

Other features in NoNoise Al include:

e Selective application of noise reduction and sharpening using Layers. You can create
multiple copies of your original image as separate layers and use NoNoise's masking tools to
select areas where you wish to apply different levels of noise reduction and sharpening. It's
perfect for those times when you wish to apply more aggressive noise reduction to areas like
shadows, while preserving details in midtones and highlights.

e Crop and retouching tools. Crop your photos and remove dust spots and other imperfections
directly from within NoNoise.

e A full-function Export feature, which lets you save images in all standard file formats, quickly
and easily. You can save specific export options as a preset, and can export using multiple
presets simultaneously.

NoNoise Al Workflow Recommendations

The advanced Al neural networks behind NoNoise Al work at the deep raw level. They are trained to detect
and reduce the noise before the raw data is even converted to a photo, preventing noise from propagating
further up in the image processing pipeline. As a result, NoNoise can clearly differentiate between what is
noise and what are small details, helping to maintain sharper details and reduce false color.

Because NoNoise Al works best at the raw image level, we recommend that you process your images in
NoNoise before you apply basic editing (exposure, color balance, etc.) or finish editing. Ideally, you want to
work with the raw data as much as possible. Processing non-raw files, even high-resolution, 16-bit formats
like PSD files or TIFFs, won't benefit as much from the noise-reduction capabilities in NoNoise as raw files
will.

If you use Lightroom Classic or Capture One, you can send DNGs to NoNoise Al from within those apps,
which lets you preserve the fidelity of the raw files. When using other editing apps, we recommend
processing the original raw files in the standalone version of NoNoise Al, saving them as a DNG, and then
opening (or importing) them into your editing app. Specific instructions on using NoNoise Al with other
apps begins on page 7.

NOTE: When using NoNoise Al as your initial processor, make sure you turn
off any noise-reduction settings inside your primary editing app.

ONT1 NoNoise Al 2024 User Guide Part 1: Overview 2



Getting Help

You can find help documents for NoNoise
Al in the Help section of the ON1 website
(onlhelp.zendesk.com). There, you can
search our Knowledge Base for frequently
asked questions and more. Video tutorials
for NoNoise can be found at onl.com/

videos.

Inside ON1 NoNoise Al, you can use the
Learning Hub to directly display videos for
getting started with the app, search the
ON1 online help system—including with
and online chat assistant—and the ON1
Shop, where you can purchase add-ons and
courses for ON1 NoNoise Al.

The Learning Hub is accessible via the Help
menu or from the Help icon at the bottom of

the left bumper panel.

Latest in ON1 Plus

ON1 NoNoise Al
User Guide

Loyalty Rewards

World-Class Support

ON1 support is available Monday through Friday 8am-5pm U.S. Pacific time. We're here to help!

The Learning Hub is available directly within ON1 NoNoise Al 2024, and includes

Learning Hub

Notifications @

Shop Help

Knowledge
Base

=

Video
Library

links to videos (which can be played directly in the Hub), ON1’s online help system,

and the ON1 store.

System Requirements

MINIMUM RECOMMENDED
macOS 11 and above; Windows 10/11 (current macOS 12 or Windows 11 (current maintenance
OPERATING SYSTEM maintenance releases, 64-bit only) releases, 64-bit only)
4-core Intel or AMD processor with 64-bit 8-core Intel or AMD processor with 64-bit
PROCESSOR support, 2 GHz or faster with SSE 4.2 or later; | support, 2 GHz or faster with SSE 4.2 or later;
Apple Silicon Apple Silicon
RAM 8 GB 16 GB or more
HARD DRIVE 1.5 GB for installation 1.5 GB for installation; SSD drive
Windows: DirectX 12, DirectML, Vulkan 1.1, | Windows: DirectX 12, DirectML, Vulkan 1.1,
DISPLAY
and OpenGL 4.2 compatible video card with and OpenGL 4.2 compatible video card with
2GB VRAM, 1920x1080 resolution (at 100% 8GB VRAM, 1920x1080 resolution (at 100%
scale factor) scale factor)
macOS: Metal, Vulkan 1.1, and OpenGL macOS: Metal, Vulkan 1.1, and OpenGL
4.2 compatible video card with 4GB VRAM, 4.2 compatible video card with 8GB VRAM,
1920x1080 resolution (at 100% scale factor) 1920x1080 resolution (at 100% scale factor)
OPTIONAL Current versions for Photoshop CC; Photoshop Elements; Photoshop Lightroom Classic; Apple
Photos; Affinity Photo; Corel Paint Shop Pro 2019 and above; Capture One
APPLICATION
INTEGRATION
A high-speed internet connection and active account for activation, auto-update checking,
INTERN ET content downloads, and tutorials.
Supports ICC/ICM profiles for camera input, display, soft-proofing, and printing. Hardware
SUPPORTED OPTIONS display calibration tool is recommended.
LANGUAGES English, German, Spanish, French, Japanese, Korean, Simplified Chinese, Russian, Portuguese,

Italian, Dutch

ON1 NoNoise Al 2024 User Guide
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Installation

To install NoNoise Al, you must first download
and install the ON1 Application Manager, which
manages your ON1 applications and free trials.
Once you've installed the Application Manager,
double-click on the app icon. You will first be
prompted to sign in to your ON1 account. The
Application Manager will then communicate
with the ON1 servers, and display any apps you
already have installed, as well as any newer apps
that are available for your account. To install
NoNoise, choose Available from the list on the
left side of the window, and click on the Install
button for the ON1 NoNoise Al 2024 item. The
Application Manager will install NoNoise in the
proper location, and add it to the Installed
section. From there, you can open the app. The
first time you launch NoNoise Al, you'll need to
sign in again to your ON1 account; after that
you're software will be authenticated.

Your license lets you install NoNoise on two
computers. When you enter your ON1 account
info, ON1’s activation server registers your
software for that computer. If you wish to move
your copy of NoNoise to a new computer, and
you are not going to be using the older one,

it is best to sign out of the old computer first.
Open NoNoise and select Sign Out from the
Help menu. This will deactivate NoNoise Al on
the current machine, and you can install and
sign in on another machine from the Application
Manager.

FREE TRIAL VERSION

NoNoise Al can also operate as a fully featured
trial version for 15 days from when you first
launch it. This gives you time to evaluate the
product and see if it fits your needs. To install
NoNoise as a trial, click on the Free Trials label in
the Application Manager, and click on the Install
button. The Application Manager will display the
number for days left in your trial; to purchase
NoNoise, click on the Buy button in the Free
Trials section, or the Buy Now button in the top
right corner of the NoNoise window.

ON?1 Application Manager

Sign In

Sign in

The Application Manager is used to install and manage your ON1 apps and
plugins. The first time you launch it, you'll need to sign in with your ON1
account details.

ON1 Application Manager 2023.298

Installed

Free Trials

ON1 Effects 2023 Install

ON1 HDR 2023 Install

I} ON1 NoNoise Al 2023 Install

ON1 Portrait Al 2023 Install

ONT1 Resize 2 Install

ONT1 Resize Al 2022

ON1 Photo RAW for Mobile

ONT Everything Plus Subscription 18 Yearly
Refresh

ON1 Application Manager 2023.298

Available

Free Trials

Refresh

When using the ON1 Application Manager, the Available section (shown top)
will list all licensed apps and plugins associated with your account. You can
install any of those apps by clicking on the Install button, after which they will
be listed in the Installed section of the Manager.

ON1 NoNoise Al 2024 User Guide
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MAC INSTALLATION LOCATION

On a Mac, the application is installed in the NoNoise Al folder in the Applications folder.

If a previous version of ON1’s NoNoise, Perfect Photo 10 or Perfect Photo Suite is found, it will be
maintained or replaced based on your preference during installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS INSTALLATION LOCATION

The application is installed in the NoNoise Al folder in the \Program Files\ON1\ directory. If a previous
version of ON1's NoNoise, Perfect Photo 10 or Perfect Photo Suite is found, it will be maintained or
replaced based on your preference during installation.

Support files are installed into \ProgramData\ON1\.

UPGRADING FROM PREVIOUS VERSIONS

If you have earlier versions of NoNoise on your computer, the installation process will move over any
presets.

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the
Product Improvement Program. The Product Improvement Program is built into our software and gathers
information about how our software is used. It is the most accurate way for us learn what features are
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you
use our programs and basic information about your computer. This information helps us learn what features
are important to you and how we can make our software easier to use. No personal information is collected
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch NoNoise Al.
You can change your participation later, just click the Help menu, then Help Improve ON1 Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Launching NoNoise Al as a Standalone App

MACOS

Open the Finder and navigate to the Applications folder. Open the ON1 NoNoise Al 2024 folder, and
double-click on the ON1 NoNoise Al 2024 application icon. You can add ON1 NoNoise Al 2024 to your
dock for easy access by clicking and holding the icon in the dock and selecting the Keep In Dock option. If
you use Launchpad it can be found there as well.

ONT1 NoNoise Al 2024 User Guide Part 1: Overview 5



WINDOWS 10

Open the Start screen by pressing the Window key. Select ON1 NoNoise Al 2024.

If you selected the “Add lcon to Desktop” option during installation you can also access ON1 NoNoise Al
2024 from there.

NONOISE Al OPENING SCREEN

When you launch NoNoise as a standalone app, the main window will have a single button in the center of
the screen: Open Photos. You can either drag images or folders into the window, or click the button to add
images from your operating system'’s file-selection window.

ON1 NoNoise Al 2024

Once you've selected an image (or images), you'll be presented with the primary editing window inside
NoNoise. (See “Using NoNoise Al” on page 21 for more.)

Uninstalling ON1 NoNoise Al 2024

To uninstall NoNoise, first deactivate your product: open ON1 NoNoise Al 2024 and select Sign Out... from
the Help menu. (This will allow you to transfer your license to another computer.) Then, follow the steps
listed below, based on your operating system.

MACOS

Go to the Applications/ON1 NoNoise Al 2024/Documentation folder. Double-click on the Remove ON1
NoNoise Al 2024 application and follow the on-screen instructions.

ON1 NoNoise Al 2024 User Guide Part 1: Overview 6



WINDOWS

Go to Control Panels. Under Programs select Uninstall a program. In the list, select ON1 NoNoise Al 2024
and click on the Uninstall button.

Working with Files

NoNoise Al has been optimized to work with raw files (and DNG files) from all major camera manufacturers,
and as such, is designed to be used before the intake process in your primary editing app. See “NoNoise Al
Workflow Recommendations” on page 2 for information.

For those times when you don’t have the original raw file, NoNoise can view and open all of the following
file types, in RGB color, at either 8 or 16 bits per pixel (where applicable):

e Photoshop (PSD)

e Photoshop Large Document (PSB)

e Tagged Image File Format (TIFF)

¢ Joint Photographic Experts Group (JPEG)

e Portable Network Graphic (PNG)

e High Efficiency Image Format (HEIC)

In standalone mode, when you are finished editing your photo in NoNoise Al, the app will prompt you to
save your processed image as a DNG, PSD, PSB, TIFF, JPG or PNG. For the highest fidelity in your editing
environment, you should use DNG as your primary format when saving or exporting raw images.

Using NoNoise Al with Adobe Photoshop

When you edit an image sent from Photoshop to NoNoise, you are editing Photoshop’s currently selected
layer. By default, NoNoise makes a copy of the layer, so your original layer is saved, unless it is a Smart
Object (see below). If you'd like to change this preference, see the Plug-Ins section of the Preferences
window on page 83.

ON1 NoNoise 2024 is accessible from within Photoshop in two ways, from the File > Automate menu, and
from the Filter > ON1 menu.

There are two additional options for editing an image in NoNoise: you can send the layer to NoNoise for
one-time processing, or you can save the editing layer as a Smart Object in Photoshop, which will let you
re-process the photo in NoNoise with your previous settings intact.

For optimal results when working with raw images in conjunction with Photoshop, you should process the
raw files in the standalone version of NoNoise Al, export them as DNGs, and then open them in Photoshop.
See “NoNoise Al Workflow Recommendations” on page 2 for more information.
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EDITING A PHOTO FROM PHOTOSHOP FOR FINAL EDITING

To use NoNoise inside Photoshop, when you do not wish so be able to re-edit your operations:

1. Open the image you want to work on in Photoshop.

2. Select the layer you want to work on. (Depending upon your Plug-Ins Preference, make a
duplicate if you want to preserve the original layer (Layer > Duplicate))

3. From the Filter menu, select ON1 and then ON1 NoNoise 2024.
4. When you're finished editing your photo, click the Done button in NoNoise.

EDITING A PHOTO FROM PHOTOSHOP TO PRESERVE SETTINGS

To be able to re-edit your Photoshop images at a later point inside NoNoise, you will use Photoshop’s Smart

ObjeCt teChnOIOgy: Quick Export as PNG

Export As...

1. Open the image you want to work on in Photoshop. ) i L e

2. Select the layer you want to work on.

3. Right-click on the layer and choose Convert to Smart Object.

4. From the Filter menu, select ON1 and then NoNoise. Right-clicking on a layer in Photoshop’s
Layers panel gives you the option to

5. When you're finished editing your photo, click the Done button turn the layer into a Smart Object..

in NoNoise.

To re-edit your Smart Object layer again inside ON1 NoNoise 2024,
double-click on the ON1 NoNoise item in the edited Smart Object layer
in Photoshop (shown on the right). NoNoise will then launch and let you
adjust your previous settings or make new ones.

Layers
Q Kind me@eTHOR®
Normal v Opacity: 100% v

Lock: $ ™ a Fill: 100% v

o NoNoise Al layer
o - Smart Filters

© ON1 NoNoise Al 2024

o % Background

fx O @ m

Using NoNoise Al with Photoshop Elements

When you edit an image sent from Photoshop Elements to ON1 NoNoise 2024, you are editing Elements’
currently selected layer. By default, NoNoise makes a copy of the layer, so your original layer is saved. If
you'd like to change this preference, see the Plug-Ins section of the Preferences window on page 83.

Photoshop Elements does not support Smart Objects, so all edits done inside ON1 NoNoise 2024 are final,
once you return to Elements.

For optimal results when working with raw images in conjunction with Photoshop Elements, process the
raw files in the standalone version of NoNoise Al, export them as DNGs, and then open them in Elements.
See “NoNoise Al Workflow Recommendations” on page 2 for more information.
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EDITING A PHOTO IN PHOTOSHOP ELEMENTS

To use NoNoise inside Photoshop Elements, follow these steps:

1. Open the image you want to work on in Photoshop Elements.

2. Select the layer you want to work on.

3. From the Filter menu, select ON1 and then ON1 NoNoise 2024.

4. When you're finished editing your photo, click the Done button in NoNoise.

Using NoNoise Al with Adobe Lightroom Classic

ON1 NoNoise Al can also be accessed from

within Lightroom Classic CC, providing an i ON1 NoNoise Al 2024
. . . Show Target Collection

integrated, round-trip workflow for applying

noise reduction to a single image or a group

Save Quick Collection...

The preferred method for sending images from Lightroom Classic to NoNoise is
of Images. There are two primary ways to use via the File > Plug-in Extras submenu.

NoNoise Al with Lightroom, via the Plug-In Extras command in the File menu, or by choosing Edit In from
the Photo menu.

Using File > Plug-In Extras is the preferred method for working with raw images; because the file creation

characteristics are driven by NoNoise, it gives you additional options for editing inside NoNoise Al,
including:

e The capability to send DNGs to NoNoise Al, letting you preserve the fidelity of the raw files
as you apply noise reduction and sharpening.

e Batch processing of multiple images in NoNoise (see page 11).

USING PLUG-IN EXTRAS FROM WITHIN LIGHTROOM

When you access NoNoise Al through the Plug-in Extras Preferences
menu, the file handling is controlled via the Lightroom Coneral Flles [CBUGES) System
section in the Plug-Ins tab of the NoNoise Al Preferences s

window. These options can be configured in advance,
based on your workflow, and, depending upon how you
set it up, can be changed as desired when working inside
Lightroom.

Leave "ON1 NoNoise Al 2024" Open when Done

Apply Results to Copy of the Current Layer v

Start with the Last Used Settings
Lightroom
FileType  DNG (No Layers) v

The file export options include the following settings:

Space Adobe RGB 1998

Bit Depth  16-bit v

¢ File Type: This determines what type of file will
be created. The default is DNG— NoNoise Al’s
optimal format—but you can also select PSD, JPG Use Original for Single PSDs
or TIFF. (G

Apple Photos

Resolution 300 pixels/inch

Stack with Original

e Color Space: The color space menu determines
which working color space is used; Adobe RGB
1998, sRGB or ProPhoto RGB.

Enable Helper
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e Bit Depth: Sets the exported file’s bit depth to either 8 or 16 bits per pixel.
¢ Resolution: Determines the resolution of the newly created file.

e Stack with Original: When enabled, the new image is stacked with the original image upon
return to Lightroom from NoNoise Al.

¢ Use Original for Single PSDs: When enabled, if you select a single image in PSD format, the
original file will be edited, rather than a copy.

e Ask Every Time: When checked, Lightroom will present these export copy options whenever
you chose an item from Plug-In Extras . Turning this off will bypass the export window inside
Lightroom, using these options..

NOTE: The Color Space, Bit Depth and Resolution options are not applicable
when the export file type is set to DNG.

If you have the Ask Every Time option checked, you'll be presented with the Export Options window
(shown on the right) inside Lightroom whenever you send
an image to NoNoise. The Export Options window lets
you adjust the file format, color space and bit depth as
needed. If you find that you are using NoNoise's
preferred file format of DNG every time, you can make
sure that it is set in the Plug-ins Preferences tab and Edit a Copy

Export Options

What to Edit
© Edit a Copy with Lightroom Settings

This creates a copy in the file format and options based on the application
preferences with any Lr settings applied. The settings are cooked into the
photo and not re-editable.

This creates a copy in the file format and options based on the application

uncheck the Ask Every Time option. With that option, T A ot
Lightroom will automatically send your selected images
to NoNoise Al when you choose the option from the
Plug-In Extras menu, bypassing the Export Options

Copy Options

window. File Format: DNG (No Layers) e

Color Space: Adobe RGB (1998) (2]
Exporting Single Images to NoNoise Bit Depth: 1650 @ Resolution: 200 | puelsinch @
To send a single photo to NoNoise for processing, select Ask Every Time Cancel

it in Lightroom and choose Edit in from the Plug-In Extras '
submenu. The Export Options includes three choices for sending the photo:

e Edit a Copy with Lightroom Adjustments, which makes a copy of the file that includes any
edits you have made in the photo;
e Edit a Copy, which copies the original photo without any changes made in Lightroom; or

¢ Edit Original, which is unavailable as an option.

NOTE: The What to Edit options are only applicable when sending PSD, TIFF
or JPG files to NoNoise from Lightroom. When sending DNGs to NoNoise, no
Lightroom edits are incorporated, regardless of the options selected.

Clicking OK will send the image to NoNoise Al in the chosen format. When you have finished with your
processing, click Done. NoNoise will then apply all of the edits, save the file in the format you've chosen,
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and return you to Lightroom. If you have added settings in Lightroom to the original photos, those edits will
not appear automatically in the new DNG file. You can use Lightroom’s Copy and Paste Settings options or
Sync settings to apply the edited image’s settings to the NoNoise-processed DNG.

Batch-processing Multiple Images from Lightroom in NoNoise

You can also process multiple images in ON1 NoNoise Al via Lightroom. Select the images you wish to
work with in Lightroom’s Library module and choose Edit in ON1 NoNoise Al 2024 from the Plug-In Extras
submenu. The Export Options window will open with two batch options:

Pause on First Photo: Use this option when you wish to apply the exact same editing
operations to a group of photos. This option will open the first selected image inside NoNoise.
There, perform any processing options, including Details settings, retouching operations, and
cropping. When you have finished with your edits,

click Done. NoNoise will then apply all of the edits EXPATEQEIIONS

to each image in the group, and return you to Batch Options

Lightroom. © Pause on First Photo

Pause on All Photos: This option lets you Pause on All Photos

sequentially edit the images in the batch. NoNoise

will open each image in the destination tab, where AskEvery Time  Cancel  (SISNND
you can edit it as desired. When you are finished " The Batch Options window comes up when you wish to
editing with one photo, click Done, and NoNoise send a group of photos from Lightroom to ON1 NoNoise

Al for processing. (If you have the Ask Every Time option
will save that photo and open the next one, with the set in NoNoise’s Preferences, this will be displayed as a

previous photo’s NoNoise settings applied. (You can section in the Export Options window.)
reset any or all of those settings as desired.) When you have finished editing the last photo in
the group, clicking Done will save the image, close NoNoise and return you to Lightroom.

USING “EDIT IN" FROM LIGHTROOM

When using the Edit In > ON1 NoNoise Al 2024 submenu from Edit Photo with ON1 NoNoise Al 2024
Lightroom’s Photo menu, you are using Lightroom'’s external

editor system to control the characteristics of the edited file,

What to Edit

© Edit a Copy with Lightroom Adjustments

and, as such are limited to PSD, JPG and TIFF.

When you use the Photo > Edit In submenu, Lightroom will ask
you each time how you wish to edit the selected image. You
have three editing options:

Edit a Copy with Lightroom Adjustments, which ¥ Copy il Siions

makes a copy of the file that includes any edits you File Format: | PSD @

have made in the photo; Color Space:  Adobe RGB (1998) 2]
Bit Depth: 16 bits/component <]

Edit a Copy, which copies the original photo without

any changes made in Lightroom; or Resolution: {300

Edit Original, which sends the original version of the
photo to NoNoise, unless the photo is a raw file, in Cancel
which case the option will be unavailable.

In Copy File Options, you set the type (TIFF, PSD, JPEG), the color space and bit depth for the resultant file.
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When you have set your options and click the Edit button, Lightroom will create a new file (or send the
original) and launch NoNoise. When you're finished, click the Done button to save your changes, close
NoNoise, and return the file to Lightroom. To return to Lightroom without saving your edits, click Cancel.

NOTE: For optimal results when working with raw images, it is best to process
files in NoNoise Al as DNGs via the Plug-In Extras menu option. This option
gives you better color and tonal fidelity, and batch processing options. See
“NoNoise Al Workflow Recommendations” on page 2 for more information.

Using NoNoise Al with Capture One

Similarly to Lightroom, Capture One can process either

single images or a group of images inside NoNoise Al, and
can export those images as DNGs. When you edit images
sent from Capture One to ON1 NoNoise Al, Capture One
creates a variant of each photo for processing in NoNoise.

To edit a single image inside Capture One:

1. In Capture One, open and select the photo
you wish to open in NoNoise.

2. From the Image menu, select Image > Edit
With > ON1 NoNoise 2024.

3. Choose the file characteristics you wish to use
in NoNoise—use DNG for the best results—
and click the Edit Variants button to launch
ON1 NoNoise Al.

4. When you're finished processing your photo,
click the Done button in NoNoise Al. Your
photo will be saved in the selected format and
returned to Capture One.

Processing multiple images inside Capture One is nearly
identical; you select the images you want to work on,

and select Image > Edit With > ON1 NoNoise 2024.

The export window in Capture One will now have an
additional tab at the top, ON1 Batch. There are two batch
options:

e Pause on First Photo: Use this option when you
wish to apply the exact same editing operations
to a group of photos. This option will open the
first selected image inside NoNoise. There,
perform any processing options, including
Details settings, retouching operations, and

v Format & Size

Format DNG

v Adjustments

Crop Respect crop

Sharpening  No Output Sharpening

v Metadata

Keywords  All
Metadata v Rating and Color Tag
v Copyright
v GPS Coordinates
v Camera Metadata
v All Other Metadata
Workflow Annotations

Overlay

Cancel Edit Variants

When editing a single image from within Capture One, you only
need to select the file format (DNG is recommended) and click Edit
Variants.

v~ ON1 NoNoise 2024
ON1 Batch

Options  pause on First Photo

v Format & Size

Format DNG

v Adjustments

Crop Respect crop

Sharpening  No Output Sharpening

> Metadata

Cancel Edit Variants

Batch processing multiple images inside Capture One gives you a
new export tab, which lets you choose one of two processing
options inside NoNoise Al.
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cropping. When you have finished with your edits, click Done. NoNoise will then apply all of
the edits to each image in the group, and return you to Capture One.

Pause on All Photos: This option lets you sequentially edit the images in the batch. NoNoise
will open each image in the main window, where you can process it as desired. When you
are finished editing with one photo, click Done, and NoNoise will save that photo and open
the next one, with the previous photo’s NoNoise settings applied. (You can reset any or all
of those settings as desired.) When you have finished editing the last photo in the group,

clicking Done will save the image, close NoNoise and return you to Capture One.

When using either the single-image or the batch method, after you've returned to Capture One, your

processed images will be visible in the current collection. As is the case with other editing apps, you should

make sure that you are not applying any additional noise reduction inside Capture One.

Using NoNoise Al with Apple Photos

ON1 NoNoise Al 2024 integrates with Apple

Photos (for MacOS only) and provides a ° < Extensions
seamless experience for enhancing your images. Q Added extensions

If you wish to edit raw photos in NoNoise, B o -
they must not have been edited inside Photos; Wallpaper |  select extensions for editing photos:
otherwise, a JPG will be sent to NoNoise. :::z:: B ot ovoise 12024

If you have Photos on your computer when you ) Lock screen

install ON1 NoNoise Al 2024, the appropriate Login Passil

& Users & Grou|

plugin will be installed, but you will need to
manually activate it in order to use it. To do so,

Passwords

&) Internet Accol

go to Apple’s System Preferences and click on R

the Extensions icon. In the Extensions pane O wallet & Appl

(right), click on Photos, then check the ON1 rick's Powerb, )
NoNoise Al 2024 option. This will let you send R

Matise

images from Apple Photos to NoNoise Al 2024.
(File Sharing must also be turned on in System Preferences for this to work.)

To edit an image in ON1 NoNoise Al 2024 follow these steps:

1. Select the image you wish to edit in Photos.

2. Click on the Edit button. T ON1 NoNoise Al 2024
3. On the right side of the window, in the editing ® App Store...

controls, you'll see an Extensions pop-up. Click that

. @ Manage...
button, and choose ON1 NoNoise Al 2024.

) Color

4. Click Done in NoNoise to return to Photos.

In Apple Photos, click the pop-up menu next to the

Mail,
Add to

Extensions label when editing a photo and you'll see the
options for sending your photo to NoNoise Al 2024.

NON-DESTRUCTIVE EDITING WITH APPLE PHOTOS

When you send an image from Apple Photos to NoNoise Al, any settings you apply will be saved with

the image, so that you can send the image back to NoNoise Al with your edits intact, as long as you do not
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subsequently edit that image inside Photos. To re-edit an image processed inside NoNoise Al, click on the
image in Photos and follow the same three steps above. When your image is opened inside NoNoise Al, you
will see all of the changes you made in your previous session.

Once you make any editing changes to your image inside Photos, your NoNoise Al edits will be “baked in”
to the image. Sending the image again to NoNoise Al will re-apply new noise-reduction settings, which is
not recommended.

If you wish to keep your original NoNoise Al edits, duplicate the image inside Photos (Image > Duplicate),
which will create a new virtual copy of the file. You can then edit one of the versions in Photos, using the
other one to preserve your NoNoise Al edits.

Using NoNoise Al with Corel PaintShop Pro

When you send an image sent from Corel PaintShop Pro (Windows-only) to ON1 NoNoise Al, you are
sending PaintShop Pro’s currently selected layer. To use NoNoise inside PaintShop Pro, follow these steps:
1. Open the image you want to work on in PaintShop Pro.
2. Select the layer you want to work on.
3. From the NoNoise menu, select Plugins > ON1 > ON1 NoNoise Al 2024.
4. When you're finished editing your photo, click the Done button in NoNoise.

PaintShop Pro does not support nondestructive editing with NoNoise Al; if you would like to work on a
copy, before you send the photo to NoNoise, right-click on the PaintShop layer and choose Duplicate.

NOTE: For optimal results when working with raw images in conjunction with
PaintShop Pro, you should process the raw files in the standalone version of
NoNoise Al, export them as DNGs, and then open them in PaintShop Pro. See
“NoNoise Al Workflow Recommendations” on page 2 for more information.

Using NoNoise Al with Affinity Photo

ON1 NoNoise Al can be accessed from within Affinity Photo, providing an integrated, round-trip workflow
of your images on both MacOS and Windows. To use NoNoise Al as a plugin to Affinity Photo, you must
first activate the plugin from within Affinity Photo.

ACTIVATING NONOISE FOR USE WITH AFFINITY PHOTO (WINDOWS)

1. To setup NoNoise Al as a plugin on Windows, go first to Edit > Preferences and click on the
Photoshop Plugins icon.

2. Check the ‘Allow “unknown” plugins to be used’ box at the bottom of the screen.

3. When you click on the Close button, Affinity Photo will prompt you to restart the app.
When you do this, you should now see NoNoise Al listed in the Detected Plugins section of
the Photoshop Plugins preferences.
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ACTIVATING NONOISE Al FOR USE WITH AFFINITY PHOTO (MACOS)

Setting Affinity Photo up for MacOS is nearly identical to the Windows activation; there is one additional

step.

. Go first to Preferences, located in the Affinity Photo menu on the top left. Click on the

Photoshop Plugins icon.

. Check the ‘Allow “unknown” plugins to be used’ box at the bottom of the screen.

. Click on the Authorize Global button at the bottom of the window. MacOS will present you

with a dialog box that shows the root folder of your system. Click on the Authorize button in
this box.

. (This step is only needed if you have the App Store version of Affinity Photo.) Click on the Add

button underneath the Plugin Search Folders area, and navigate to Applications/ON1
NoNoise Al 2024/Plug-in Files/fON1 NoNoise Al 2024.plugin. Click OK.

. When you click on the Close button, Affinity Photo will prompt you to restart the app.

When you do this, you should now see NoNoise Al listed in the Detected Plugins section of
the Photoshop Plugins preferences.

Preferences

tHHER Photoshop Plugins

Plugins will be automatically detected in the default folder:
Open Default Folder in Finder

Detected Plugins Plugin Search Folders
Plugin Status

ON1 NoNoise Al 2022...  Unknown
/Applications/ON1 NoNoise Al 2022/Plug-in Files/ON1 NoNoise Al/

Remove Add

Plugin Support Folders

/

v Allow "Unknown" plugins to be used Remove Add

NB: Changes made to these settings will take effect when you restart Affinity.

EDITING A PHOTO IN NONOISE Al FROM WITHIN AFFINITY PHOTO

When you edit an image sent from Affinity Photo to ON1 NoNoise Al, you are editing Affinity Photo's
currently selected layer. To use NoNoise inside Affinity Photo, follow these steps:

1. Open the image you want to work on in Affinity Photo.

2. Select the layer you want to work on.

3. From the NoNoise menu, select Filters > Plugins >ON1 > ON1 NoNoise Al 2024.
4. When you're finished editing your photo, click the Done button in NoNoise.
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Extras

NOTE: For optimal results when working with raw images in conjunction with
Affinity Photo, you should process the raw files in the standalone version of
NoNoise Al, export them as DNGs, and then open them in Affinity Photo. See
“NoNoise Al Workflow Recommendations” on page 2 for more information.

ON1 NoNoise supports two additional file types ece Exiras Managet

that can be used within the app. These files, called

= ON1

Extras, include the following: @ COP-logo-2017

Brush shapes, which are generally black-
and-white TIF files. You can also import
custom brushes saved in the Adobe Brush
Preset format (.abr). These brushes are
can be selected and used while retouching
with the Masking Brush in NoNoise’s
Layers mode (see page 58).

Watermarks, image files (transparent
PNGs) that can be used with the
Watermark pane of NoNoise Al's Export
function (see “Using graphics-based
watermarks” on page 47).

Import | Delete Delete
" Close

The Extras Manager

To manage these files, choose Manage Extras from the File menu. To import either a brush shape or a
watermark file, click on the label at the top of the window, then click on the Import button in the footer of
the left column. A dialog box will appear where you can select the files to import. If you want to import an
entire folder, open the folder, select the first file, then shift-click on the last file. Click Import when your
selection is complete. Then, select a category for your extras to live, which is where you will be able to find
it inside NoNoise. You can select from an existing category or create a new one.

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

. Open the Extras Manager in any module (File > Manage Extras).

. Click on the extras type that contains the content you wish to remove. This will display

categories within that type.

. To delete an entire category, select in the left column and click on the Delete button in the

footer of the left column.

. To delete individual extras, select them in the right column and click on the Delete (‘- in the

Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.

ON1 NoNoise Al 2024 User Guide Part 1: Overview 16



Customizing NoNoise Al

NoNoise Al has a number of parameters you can change within the app, including the creation of custom
keyboard shortcuts; setting the interface’s font size; customization of various panes; and how the app
works with a mouse scroll wheel.

KEYBOARD SHORTCUTS
You can customize ON1 NoNoise Al 2024’s hotkeys Keyboard Shorteuts
via the Keyboard Shortcuts window. This window Default v Summarize
lets you view and change the shortcuts for any Gl 5earch
tool, tool option or menu item inside NoNoise. You Command Shortcut

can assign shortcuts to items that don’t yet have a - loals

shortcut, build multiple sets of shortcuts as preset
styles, and create a summary of your shortcuts that
can be viewed in any web browser.

To view or change the app’s hotkeys, choose
Keyboard Shortcuts from the Edit menu. By default,
NoNoise’s shortcuts will be displayed, organized
hierarchically by the following groups:

¢ Tools, for the 13 tools available in

Original Quick Mask
Quick Mask Al

Blur Mask

Chisel Mask

Line Mask

Clone Stamp

Crop

Masking Brush

Masking Bug

Perfect Brush
Perfect Eraser
Refine Brush

Retouch Brush

NoNoise. 2o
> Tool Options
¢ Tool Options, for the brush and mask > Menu
options available in any masking tool’s
Options Bar.

e Menu, for all of NoNoise’s menu items.

You open each group by clicking on the triangle to the left of the group name, or you can use the search
field at the top of the Keyboard Shortcuts window to search for a command in any of the groups.

Each command that has an assigned key will display that key in the Shortcut column. The Shortcut field
will be empty for any command that doesn’t have an assigned key, and any field with a grayed-out shortcut
means that you cannot modify that command’s keys.

NOTE: Some keyboard shortcuts cannot be changed. These include menu
commands used by the operating system (Cut, Copy, Paste). Also, you can't use
the Escape, Return/Enter, or Delete keys as a shortcut.

Modifying hotkeys

The Default preset style's hotkeys cannot be modified, but you can create your own set of shortcuts by
double-clicking on any command you wish to add or change. You'll be asked if you want to create a new
preset. Clicking Yes will let you name the new preset, and NoNoise will make a duplicate of the Default set.
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At this point, you can change any existing hotkeys—or add your own shortcuts for commands that don’t
have them—by double-clicking in the Shortcut
field for that command. The field will be
highlighted, and you can press the key or key
combination you wish to use. If that key is used
by another command, a dialog will come up,
informing you of that, and giving you the option

The factory preset 'Default’' cannot be modified.

Would you like to create a new preset?

of either keeping the existing hotkey/command When you add or change a hotkey the first time, ON1 NoNoise Al will prompt
you to create a new preset style, which makes a duplicate of the Default

comblnatlon, or Changmg it to the new preset. You can switch between preset styles—including back to NoNoise'’s

comma nd . Default set—by using the pop-up menu at the top of the Keyboard Shortcuts
window.

When you change a default shortcut to a new key combination—even for commands and options that didn’t
initially have a shortcut—a Reset arrow will appear to the right of the Shortcut field. Clicking the icon will
reset the command to its original state, from the Default preset style.

To delete a shortcut, double-click in the Shortcut
field and press the Delete key.

The keyboard shortcut '88E' is currently used for the 'Merge
The Summarize button at the top of the aver:
Keyboard Shortcuts window will create an
HTML table of the current set. You'll be asked il s
where to save the ﬂle: and dOUble'CIiCking onit If you try to add a shortcut key combination that is already in use, ON1
will open that table in your default Web browser, NoNoise Al will let you know, and give you the option of keeping (Cancel) or

. K . removing (OK) the other command/shortcut.
where you can view or print the list.

Would you like to clear the keyboard shortcut for 'Merge Layer'?

You can return to the original NoNoise shortcuts by clicking on the pop-up menu at the top of the
Keyboard Shortcuts window, and choosing Default from the list of preset styles. That menu can also be
used to create a new preset or to delete an existing one that you created. The Default preset cannot be
removed, however.

CUSTOMIZING THE DISPLAY AND ORDER OF TABS AND PANES

You can show or hide and rearrange certain
aspects of NoNoise’s interface via the Tab
option pop-up menu, which is found in the
primary photo information panes at the top of
the right panel in the app, or in the Properties Nav Levels

NE Levels Info History Snapshot:

. v/ Nav

window (or pane). Panasonic DMC-GF1 e
45 mm (Leica DG Macro-Elmarit 45mm f/2.8) . Info
To view the menu, hover over the end of the 10/29/2010 2:53:13 PM
. . . . . . Histo|
top pane in the panel, which will display the SUOURCEIORR Dl < n; .
: . napshots
Tab options icon, represented by three, evenly
spaced vertical lines. Clicking on the icon will IS0 800
display a list of the separate panes that make up The Tab options pop-up menu is displayed when you hover over the end
. of the top pane in NoNoise (circled in red, top). Clicking on the icon will
the group. By default, all five panes (Nav, Levels, display a pop-up of the separate panes; selecting one of the items in the
Info, History and Snapshots) are displayed. list will remove (or add) that item from the pane.
) y p play p

Selecting any of the items in that list will hide
that pane. To restore a hidden pane, go to the
Tab options menu and select it again.
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In addition to showing and hiding certain panes, you can also rearrange the order of the visible tabs in the
group. Click and hold the mouse on a tab you wish to
move and slide it right or left to reorder the tab. Le Info nfo Nav

NoNoise’s Properties feature has a similar Tab option icon
that lets you hide one of the tabs (Blending or Masking) i . :

. L. . L. . . . Reordering the top panes is easy: click and hold the mouse
from view. This icon is visible in either of the Properties on a tab you wish to move, and drag right or left (top). When

display OptiOI’lS' window or pane in the rlght panel you let go of the mouse button, the tabs will be in a new
: : order.

Info Levels Nav

NOTE: For information on the panes at the top of the right-hand panel, see
“NoNoise Al Photo Information Panes” on page 38. The Properties window
is discussed in detail starting on page 73.

CHANGING THE FONT SIZE

By default, NoNoise Al prioritizes the main workspace to focus on photos, using a small font size to display
panel names, labels, file names any other basic text. You can adjust the default font size to one of three
settings, Small, Medium or Large, by choosing the General tab of NoNoise's Preferences window. Select the
option from the Font Size pop-up, and restart NoNoise to have the effect take place.

Levels Info Levels Info
Sony ILCE-7RM5
73 mm (Sony FE 24-105mm F4 G 0SS)
4/13/2023 10:50:27 AM

36 + 83.3 MB * RAW

Sony ILCE-7RM5

73 mm (Sony FE 24-105mm F4 G 0SS)
4/13/2023 10:50:27 AM

9504 x 6336 - 83.3 MB * RAW

I1SO 6400
1SO 6400

ayors IS0 6400  1/250

Layers
Layers

Noise & Sharpening

Noise & Sharpening Noise & Sh .
oise arpening

NoNoise Al Tack Sharp Al Both
8 Adjust

NoNoise Al Tack Sharp Al Both
8 Adjust NoNoise Al Tack Sharp Al Both

8 Adjust

ON1 NoNoise Al 2024 User Guide Part 1: Overview 19



USING A SCROLL WHEEL

When you are using ON1 NoNoise 2024 with a mouse that has a scroll wheel, there are number of different
options available throughout the app, on both Mac and Windows.

Throughout NoNoise, the scroll wheel has the following general options:

e Using the scroll wheel will pan up and down in the current window. In Browse’s Thumbnail
view, it will scroll the window. In most other views, using the scroll wheel with the cursor
over the preview area will pan the image on screen up and down. Holding the Shift key down

and scrolling will pan left or right.

¢ Hold Option (Mac) or Control (Windows) with the scroll wheel to zoom in or out of an image.

In the Edit module, when working with any tool that has a brush size and feather option, press Command-
Option (Mac) or Control-Alt (Windows) and scroll to change the brush size. To change the feather, press

Option-Shift (Mac) or Alt-Shift (Windows).

NOTE: If you only want the scroll wheel to change brush size, turn on the
“Only Adjust Brush Size with Scroll Wheel” option in NoNoise's General

Preferences tab. See page 81.
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PART 2: USING ON1NONOISE Al

ON1 NoNoise Al 2024 (_DSC1541.ARW @ 100.0% 16-bit)

Levels

E Layers

F  Noise & Sharpening

Above is an overview of the primary NoNoise Al window with an image open for processing (see page
22 for a view of the window when working with multiple images):
A. Tool Well: Tools for cropping, retouching, creating masks, and for adjusting the view level.
B. Preview Window: Displays the current photo in detail view.

C. Preview option toggles: Magnification slider for current image, compare (before/after) mode,
show/hide mask, preview on or off (displays original version). Drop-down menu at the right
has mask overlay options.

D. Photo Information pane: Navigator, Levels (histogram), Info, History and Snapshots panes.
E. Layers pane: Add, edit and manage layers here.

F. Noise & Sharpening: NoNoise Al’s pane for applying noise reduction and sharpening to an
image. There are three options: applying NoNoise Al only, applying TackSharp Al only, or
applying both.

G. Reset bar: Reset all resets all settings), Cancel (cancels all settings and returns to opening
screen or host app), Done (finishes operation).

H. Export/Close Panel: Top icon presents the Export window for exporting the current photo or
photos. Bottom icon opens and closes the right panel.

Detailed descriptions of the elements in the NoNoise Al processing window start on page 30.
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Opening a Photo inside NoNoise Al

When you open a raw file inside NoNoise Al, it analyzes your image and applies ON1’s Al-driven noise-
reduction technology, based on the contents of the image. NoNoise initially presents your image at 100%
view, with a split screen displaying your original raw on the left side, and the denoised version on the right.
NoNoise automatically selects the Hand tool when this happens, so you can drag the image around the
preview area to look at specific areas of interest. The center slider can be moved left or right, displaying
more (left) or less (right) of the image with the current noise-reduction settings applied, and you can also
zoom further into (or out of) the image by adjusting the Zoom setting at the top of the window.

N

enn
When you open a raw image for processing inside NoNoise Al, the app will apply initial noise reduction based on the contents of the image and your
noise-reduction preferences (High, Medium or Low). The image will be displayed at 100%, with a preview slider that can be dragged left or right; the original
image is on the left side of the slider, while the right side displays the denoised image with the current settings in the NoNoise Al tab.

NOTE: When you send a raw file to NoNoise Al from a raw editor like
Lightroom or Capture One, you will not see any edits that have been made to
your photos in those applications.
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Noise & Sharpening

NoNoise Al  Tack Sharp Al Both

o *Apply

Nol ode Auto On

Luminance

Noise & Sharpening

N Al Tack Sharp Al Both

o Apply

T arp Al Model 2024 v Auto On

Tack Sharp Al Deblur 100

— e

Inside The Noise & Sharpening Pane

Noise & Sharpening

seAl TackSharpAl  Both

o Apply

Aodel 2024 v Auto On

Luminance 00

———————————————————

Micro Sharpening 100 Enhance Detail

) ®

Enhance Detail

——y

Micro Sharpening 0 Ta od Auto On
Tack Sharp Al Deblur 100
R, )
Micro Sharpening 00

e

NoNoise Al's Noise & Sharpening pane has three options; NoNoise Al (left), which only applies ON1’s Al-based noise reduction to your photo; TackSharp Al
(middle), which only applies ON1’s focus-enhancement and sharpening technologies. The Both tab (left) lets you apply both NoNoise and TackSharp to an image at
the same time.

The Noise & Sharpening pane incorporates the two adjustments that often compete with each other when
working on a photo, and that generally need to be balanced in order to achieve satisfactory results in your
edits. There are three options for noise reduction and sharpening in the pane, split into tabs:

¢ NoNoise Al, which uses Al-based machine learning to remove luminance and color noise from
photos shot at higher ISOs.

e TackSharp Al, another Al-based tool, designed to deblur or sharpen soft photos.

e Both, which includes the NoNoise Al and TackSharp Al tabs, letting you apply Al-based noise
reduction and focus-sharpening applications at the same time.

WORKING IN THE NONOISE Al TAB

NoNoise Al automatically applies noise reduction based on the contents of your image and your preferred
level of reduction, but you can adjust the amount of noise reduction and detail preservation—as well as add
sharpening—to your taste, by adjusting the sliders in the Noise & Sharpening pane. The controls consist of
two primary sections in the main section of the pane, and an action area on the top right side of the pane:

A. Noise Reduction: This section adjusts the
amount of Luminance (brightness) and
Color noise reduction on the current image.
Enhance Detail works to preserve details
that would have been lost in traditional 0
noise-reduction processes. Color is always
set to 100, but the amount of Luminance
reduction is set based on the image
contents and your Auto settings level (see
below). The NoNoise Al Model pop-up
offers three options: 2024, the preferred G
setting for raw files; Original, which was
NoNoise’s first noise-reduction algorithm,

Noise & Sharpening

NoNoise Al  Tack Sharp Al Both

o "Apply

NoNoise Al Model 2024 v Auto On

Luminance 100

————————————————————————————
Enhance Detail

J—

Micro Sharpening

—
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and is provided for backward compatibility reasons; and High Detail, which is optimized for
non-raw files.

B. Sharpening: This adjusts the amount of sharpening applied to the processed image. The sole
slider, Micro Sharpening, enhances small details in your image.

C. Reset: The top button resets the tab to its default state. Click this if you would like to reset
any changes you've made here.

D. Apply/Adjust: This button has two states: Apply (blue) and Adjust (red). Apply is the default
state when you open the image: NoNoise has applied noise reduction, and you can fine tune
the settings as you'd like. When you're done, clicking the Apply will ‘lock’ your settings in,
changing the state to Adjust. To re-edit your settings, click Adjust, and the button will revert
to Apply, with the current settings available.

E. Auto On/Off: When you have applied NoNoise to an image with the default reductions
settings, this button will read Auto On. If you adjust the Luminance slider, the button will
change to Auto Off, meaning that the slider has been adjusted from the auto value. Clicking
the button in this state will return the Luminance setting to its original value.

NoNoise’s Default Noise-Reduction Settings

We know that noise reduction is as much about personal taste
as it is about technology. Some people prefer a light touch,

while others like a much more processed result. In NoNoise Al’s General Files Plugins  System
General Preferences tab, you can configure NoNoise Al to use
one of three automatic noise-reduction settings—Low, Medium
or High—when you click on the NoNoise Al tab (or Both). This AR e el . &
setting only affects the Luminance slider; the Color slider’s
default is always set to 100, the Enhance Detail’s default setting Accent Color
is 50, and the Sharpening Amount is 20.

@ Preferences

Font Size Small v

Blue Orange Green Red Purple

Application Language Auto v

The default Auto setting is High, but you can change it to
Medium or Low in the General tab of NoNoise Al’s Preferences
window; choose the desired setting in the NoNoise Al Default
pop-up at the bottom of the window. NoNoise Al Default High v

Check for Update on Launch

Only Adjust Brush Size with Scroll Wheel

. . Enable Split Screen Compare when in Noise Al
Our recommendation would be to play around with a group of i i

representative images from your library, looking at the types of Ok
noise reduction that work best for you, and change your setting

to thera nge that you like best The General Preferences pane has an option to
configure NoNoise Al's automatic noise-reduction

settings—to Low, Medium or High—based on your
taste. The default is High.

Fine Tuning the Image

Work the Noise Reduction section of the NoNoise Al pane first, if you need to. When thinking about
adjusting the noise reduction amounts, detail enhancement and sharpening, use the Preview window at a
zoom level that lets you see the important details, and use the Hand tool to move you around the image.
Then, work with the Luminance and Enhance Detail sliders to zero in on the best look.

A good methodology, especially as you are getting to know the app and its settings, is to set the Luminance,
Detail Enhancement, and Sharpening all to zero. Then start by adjusting the Luminance slider up, examining
an area that has both detail and smooth areas. Adjust the Luminance until you see the desired amount of
noise reduction in the smooth areas. Depending on your tastes, this will usually be in the 80 to 100 range.
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Next, increase the Enhance Detail slider until you have the desired amount of enhancement. Values
between 20 and 50 are common. High amounts on this slider may bring back some noise in the smooth
regions, so you may need to balance how much you use by comparing high-detail and low-detail areas.

Last, adjust the Sharpening Amount in the same fashion as the Enhance Detail slider. Values between 20
and 50 generally give the best results.

When you're done with NoNoise Al, click the Apply button to lock the settings.

NOTE: Because NoNoise Al works best at the raw image level, we recommend
that you process your images in NoNoise before you apply basic editing
(exposure, color balance, etc.) or finish editing. Ideally, you want to work with
the raw data as much as possible. Use the High Detail option (in the Method
pop-up) when processing non-raw files, even high-resolution, 16-bit formats
like PSD files or TIFFs.
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USING THE TACKSHARP Al TAB

The TackSharp Al tab is much simpler than the NoNoise Al tab, consisting of a method selection option and
two sliders:

A. The TackSharp Al Model has two options: Noise & Sharpening o= 0
2024, which is the (default) preferred NoNoise Al Tack Sharp Al Both
setting, and Original, which was NoNoise’s o Apply

first sharpening algorithm.

B. The Tack Sharp Al Deblur slider is designed
to enhance focus and reduce motion blur.

0 Tack Sharp Al Model 2024 v

The default setting is 100; in most cases, e Tack Sharp Al Deblur 00
) . D ——————— ]

you shouldn’t have to touch the slider,

but feel free to do so if you feel that the o Micro Sharpening

sharpening is too aggressive.

C. The Micro Sharpening slider is identical
to the one found in the NoNoise Al pane. It is designed to enhance the small details in your
image. This slider defaults to 100; as you adjust the slider, zoom in to an area with small
details, like hair or feathers, and pay attention to the effect. A little bit can go a long way.

D. Reset: The top button resets the tab to its default state.

E. Apply/Adjust: This button has two states: Apply (blue) and Adjust (red). Apply is the default
state when you open the tab. When you're done, clicking the Apply will ‘lock’ your settings in,
changing the state to Adjust. To re-edit your settings, click Adjust, and the button will revert
to Apply, with the current settings available.

ﬂ_

When you open a raw image for processing inside TackSharp Al, the image will be displayed at 100%, with a preview
slider that can be dragged left or right; the original image is on the left side of the slider, while the right side displays
the sharpened image with the current settings in the TackSharp Al tab.
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USING NONOISE Al AND TACKSHARP Al TOGETHER

The Both tab in the Noise & Sharpening pane is designed for those times when the lack of sharpness and
increased noise are an issue in a photo. By applying both NoNoise and TackSharp technologies to your
image simultaneously, you can work to achieve the right balance between the two.

When working in the Both tab, the only difference you'll find is that the Micro Sharpening slider is listed
in the TackSharp section of the tab and is not available in the NoNoise section. Otherwise, the Both tab
functions identically to the individual tabs.

SAVING YOUR WORK

When you're done with the Noise & Sharpening pane, click the Apply button to lock the settings. Then,
perform any cropping or retouching that you'd like to apply to the image. When you have finished your

adjustments, click the Done button. What happens next depends upon whether you are using NoNoise as a

plugin, or as a standalone app:

e When used as a plugin, NoNoise will close and return the processed file to the host editing
app, in the format specified by that app.

¢ When used in standalone mode, NoNoise will display a Save Photo dialog box, where you can
save the processed image as a DNG, or in any of NoNoise Al's supported file formats, if you
prefer. After saving, you will be returned to NoNoise's startup window.

Resetting an Image or Canceling Processing Entirely

If you perform a group of changes to an image, and wish to start fresh, you can click the Reset All button
at the bottom of the screen. This will remove all adjustments—noise reduction, cropping, and retouching—
from the image and return you to its initial state, with the default Auto noise-reduction settings applied.

If you wish to cancel your session entirely, click the Cancel button, which will take you back to the NoNoise

Al startup window (when working in standalone mode) or to the host app (when used as a plugin).

Processing Single Images Inside NoNoise Al

Processing an image inside NoNoise Al follows a straightforward path:
1. Open your image for processing, whether as a plugin from another app, or when using
NoNoise as a standalone app.

2. By default, NoNoise Al analyzes the image and applies noise reduction only, based your
preferences (see “NoNoise’s Default Noise-Reduction Settings” on page 24), and presents
the Preview window, with a before/after split-screen view.

3. At this point, you can choose to switch from the NoNoise Al tab to either the TackSharp Al
or Both tabs, based upon what you wish to achieve with the current photo.

4. Adjust the appropriate sliders, as desired.
5. Click the Apply button in the Noise & Sharpening pane to lock the Details setting.

6. At this point, you can perform any cropping or retouching operations, or create a new layer
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and apply different noise reduction and sharpening operations (see “Working with Layers”
on page 53).

When you've completed your editing tasks, click Done. When using NoNoise Al as a plugin, your file will be
saved in the intended file format, and you will be returned to the originating editor. When using NoNoise

Al as a standalone app, it will prompt you to save the file in a format of your choice and return you to the
startup screen.

Processing multiple images in standalone mode

When you're using NoNoise as a standalone app you have the capability to process more than one image
in a session, and have options to sync your settings from one image to another (or to all of them). The basic

workflow is essentially the same as the steps described in the single-image mode detailed on page 22,
with a few slight differences.

In this mode, a filmstrip view is presented at the bottom of the main window, containing all of the images
that are open. The currently selected image is shown with a dark blue outline—or the accent color set in the
General Preferences window—around it in the strip, as shown below.

Kl iy wid

When working with multiple images, a filmstrip is visible, showing the set of images being worked on. The current image is represented here with
the dark blue outline. You can move from image to image, applying individual settings to each image, or you can sync the settings from one image
to another or all in the group. If there is an image that you don’t wish to have saved (a reject, perhaps), Command-click (Mac) or Control-click
(Windows) on it to deselect it. When NoNoise Al exports the group, it will not export that image.

In this mode, you can use NoNoise in the manner that works best for you:

¢ If you want to process each image individually, apply your settings, retouching and cropping
to the current image; when you've completed that, click the next image in the filmstrip and
process that image. Keep working in this manner until you're finished, and then click Done.
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e |If you want to process one image as a representative (base) for the entire group and apply
those settings to all the images, apply your Details settings, retouching and cropping to
the selected image. Then, select the other images in the group and click the Sync button to
synchronize all of the NoNoise Al adjustments across the group. When all of the adjustments
have been applied, click Done.

NOTE: When using NoNoise Al in batch mode as a plugin to Lightroom or
Capture One, you still work with a single image at a time, in the same manner
discussed starting on page 22. Depending upon the option chosen in
Lightroom or Capture One, clicking Done either saves the current image and
opens the next image in the batch, or applies the same NoNoise settings to
all of the items in the batch. For more details on this process, see page 11
(Lightroom) or page 1 (Capture One).

SYNCING IMAGES
When you click the Sync button, NoNoise Al will open the o0 Apply Settings
Apply Settings window, which lets you apply any of three Cropand Level
settings across the group of selected images: NoNoise Al, iy

Crop and Level and Retouching. The NoNoise option will
always be checked (with the blue circle filled); the other
two options will only be available if you made any of those
adjustments to the base image.

All None Expand Collapse Cancel Apply

. . . The Apply Settings window. The NoNoise Al setting will always
C“Ckmg the Apply button will apply the checked optlons be available (and checked); the other two options will be grayed

to each image in the group: all of the settings in the Noise out unless you preformed that action on the base image.

& Sharpening pane, any crop, and retouching items. If you wish to bypass the Apply Settings window, and
apply all of the base image’s edits and NoNoise processing to the images in the group, choose Sync All
Settings from the Settings menu.

SAVING YOUR PROCESSED IMAGES

When you have processed all of the files in the selection—either on an image-by-image basis or by syncing
the images—and click Done, NoNoise Al will open the Export window. There you can choose an export
preset (or create your own) and destination for the processed images. NoNoise Al will then return you to
the startup window. (See “Exporting Images” on page 42 for information on using the Export feature in
NoNoise.)

NOTE: If you have images in your group that you do not wish to have
processed, before clicking Done, deselect the images by Command-clicking
(Mac) or Control-clicking (Windows) on them in the filmstrip. When NoNoise Al
exports the group, it will bypass any deselected images.
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The Tool Well

NoNoise Al has 14 tools available for you when you are working on a photo, and are accessible via the Tool
Well on the left side of the screen. Some tools—Crop, and View—are self-contained within the tool icons.
Others are nested within a tool group—Mask, Refine, and Retouch—and are accessible via the Tool Options
bar at the top of the screen when you click on one of those tool icons:

Crop Tool: Trims an image to your desired size or ratio; includes a content-aware fill option.
Shortcut key: C

Masking Brush (Mask group): Mask large similar areas quickly. (Includes
Perfect Brush option.) Shortcut key: B

Gradient Mask (Mask group): Applies a selective gradient as a mask in any
filter (or to the entire stack). Shortcut key: M

Quick Mask Al Brush (Mask group): Similar in operation to the Super Select Al
tool, this tool generates masks by clicking on regions in a photo. Shortcut key: W

Quick Mask Brush (Mask group): Create high-quality masks with only a few
strokes as guidance. Shortcut key: Command-Option-Shift W (Mac); Control-alt-Shift W
(Windows)

Line Mask Tool (Mask group): Create masks using straight lines, with the
capability to add curves and adjust mask points on the fly. Shortcut key: Shift-P

Refine Brush (Mask group): Lets you refine an existing mask’s edges, to help RetOUCh
mask difficult areas, such as hair. Shortcut key: N

Chisel Brush (Mask group): Removes fringes from the edge of a mask. Shortcut
key: Shift-H

Blur Brush (Mask group): Blurs the edges of a masked area to help it blend
more naturally. Shortcut key: L

Healing Brush (Retouch group): Non-destructively removes distractions from a
photo using content-aware fill technology. Shortcut key: Q

Perfect Eraser (Retouch group): Removes distractions like signs and power lines. Shortcut key:
Shift-Q

Retouch Brush (Retouch group): Removes blemishes like dust spots and acne. (Includes
Perfect Brush option.) Shortcut key: R

Clone Stamp (Retouch group): Paints over an area from another area. Shortcut key: Shift-S

View Tool: Adjusts the magnification of the image in the Preview area, and lets you move
around the Preview window. Shortcut key: Z

NOTE: Because masking is only applicable when using NoNoise with Layers,
information on using the tools in the Mask and Refine groups—and masking in
general—is in the Layers section, starting on page 53.

To access a tool, simply click on the tool, or use the shortcut key attached to the tool. When selected, the
cursor will change, and you will see a set of options for the tool in the Tool Options bar above the Preview
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window. If the selected tool is part of a tool group, you will see the other tools in that group, on the left
side of the Tool Options bar. Information on the Crop and Retouch tools starts on the following page.

CROP TOOL

This tool lets you crop your image, and is re-editable while you are using NoNoise Al. It also has a
content-aware option that lets you expand the photo canvas, filling the edges of a photo’s frame
with realistic detail.

To crop an image without content-aware fill, select the Crop tool from the Tool Well, which will
display the crop overlay. Select any preset crop ratio you would like to use from the Options bar — the
default is Freeform, which lets you crop in whatever size or ratio you would like. Choosing a preset size (like
4x6) will display the crop overlay at that chosen aspect ratio.

Overlay Diagonal v Aspect Original Ratio v W 8640 5760 Level f_,- Angle®

Rule of Thirds

The Crop interface, with the Crop Preset pop-up open.

Adjust the corner handles of the crop tool overlay to get the area you wish. (The area outside the crop box
appears darkened for guidance.) You can resize and move the image inside the crop box. When you are
satisfied with your settings, press the Apply button in the Options bar or press Enter.

To move the image inside the crop box, simply click and drag inside the box. You can also nudge the image
using the arrow keys on your keyboard. To resize the crop box, click and drag on any of the handles.
Clicking on a corner handle allows you to adjust two sides at the same time; clicking on a side handle allows
you to adjust that side. If you hold the Shift key down while adjusting the size, the box’s proportions are
maintained. To rotate the crop box, move outside a corner until the tool changes to rotate.

To straighten an image, you can use the Leveling Tool, which is found in the Tool Options bar when the
Crop Tool is active. Click on it, and drag the tool across an element in your image that should be level.
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Content-aware cropping

The content-aware feature lets you extend the crop beyond the edges of the frame. To use this, click the
Content-Aware option in the Tool Options bar, and move the crop handle past the desired edge. When you
click Apply, NoNoise will fill the expanded area with detail based on the content along the existing edge.

When you select the Content-Aware option in the Tool Options bar, you can extend the canvas beyond the boundaries of the existing photo.
Clicking Apply will fill the area based on the characteristics of the edges in the photo.

Crop overlays

When you select the Crop tool, NoNoise has the option to display Rule of Thirds
guidelines as an overlay on top of your photo. These overlays can be used as Grid
compositional aids for cropping. NoNoise includes a number of overlays that Diagonal

you can display during a crop session, and they can be accessed from the

overlay pop-up menu in the Tool Options bar when the Crop tool is active. Triangles
There are seven options — Rule of Thirds, Grid, Diagonal, Triangles, Golden Golden Ratio
Ratio, Golden Spiral, and None — and you can easily go back and forth Golden Spiral

between them as desired while cropping. None

In addition to overlay type, there are two other sets of options in the pop- Always Show Overlay

up menu: Auto Hide Overlay

e You can choose to have the overlay displayed all the time during
a crop session, or to have NoNoise only display the overlay when The Crop Overlay pop-up includes

your cursor is in the preview area of the workspace. seven options for setting and
displaying overlays.
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¢ When working with the Triangles or the Golden Spiral overlays, the Flip Overlay options will
be visible, letting you flip the orientation of the overlays horizontally (Golden Spiral only) or
vertically (Golden Spiral and Triangles).

Crop Tool Options Bar

Overlay Diagonal v Aspect Freeform v & H 5995 pixels v Level ;If Angle® 0 v d L Content-Aware °°

e Overlay pop-up: Selects a crop overlay, sets overlay visibility, and flips the overlay.

e Preset pop-up: Lets you choose from Freeform, constrained or custom preset ratios.

¢ Width: Sets the width of the crop box.

e Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

e Height: Sets the height of the crop box.

¢ Leveling Tool: Click and drag this tool across an element in your image that should be level.
e Angle: See and adjust the angle of rotation.

¢ Rotation tools: Rotates the photo 90° clockwise or counterclockwise.

e Reset: Resets the crop area to the size of your original photo.

e Cancel: Cancels the crop application and returns you to where you previously were in the
Edit module.

e Apply: Applies the crop.

e Content-Aware: When clicked, will expand the canvas size, filling the edges of the photo with
new detail, based on the area next to the expanded space.

Creating custom crop sizes

In addition to the preset crop ratios provided, you can create your own custom crop sizes. The bottom of
the crop preset pop-up menu has a Custom submenu, which lists all of your custom ratios. To add a size,
choose Manage Custom Sizes from the submenu. To add a new ratio, click the Add button, then enter a
name, and the width and height ratio you wish to create (the units will always be “ratio” when you create a
custom preset for the Crop tool). You can add as many as you'd like and click OK. The new crop ratios will
appear in the Custom submenu.

Freeform o0 Custom Document Size Presets

Original Ratio Width Height
1x1 (Square) 1 oddball 2 8 ratio
2x3 (4x6)
3x4 (6x8)
4x5 (8x10)

5x7

2 pano y ratio

3 website ratio

8.5x11

16x9

Custom oddball
pano
website

Manage Custom Sizes...
The bottom of the preset pop-up (above left) has a list of custom crop ratios that you can use in addition to the preset ratios.
You can create your own presets via the Manage Custom Sizes submenu option, which opens the Custom Document Size
Presets window (above right).

ONI1 NoNoise Al User Guide Part 2: Using NoNoise Al 33



HEALING BRUSH (RETOUCH GROUP)

The Healing Brush is a tool for removing distractions like dust spots, power lines and unwanted

people from your photos, using sophisticated content-aware fill technology. Like the other

retouching tools, you can apply the brush to multiple portions of an image. Unlike the other

tools, however, the Healing Brush is fully non-destructive: each area you apply the brush to is
individually editable (and removable).

To use the brush, paint over
a distraction and a matching
area of your photo will be
blended on top to replace

it, using content-aware
technology. You'll see two
circular markers: red, which
is the area that has been
removed, and green, which

is the area that was used to
fill the source. Each marker
is movable by clicking and
dragging; sometimes, you'll
want to try a different area
to match to your source.
Non-active markers will be
displayed as gray squares
until you click on them. (Press
the Delete key to remove the
current area.)

Opacity 100

Areas that use the Healing Brush will be displayed as a gray marker. Clicking on a specific marker will
display the source and area used to fill the source. You can then readjust its placement, or delete the area.

The Healing Brush has four modes, Heal, Stamp, Copy and Move. Each mode has a different approach:

e Heal mode applies content-aware matching from a nearby area to mask the object or area
being painted out.

e Stamp mode acts like the Clone Stamp tool (see page 37), applying the actual pixels from
the area used to mask the object out; unlike that tool, however, this option is non-destructive.

e Copy mode is similar to the Heal mode, except that it makes a copy of the brushed area or
object instead of masking it out.

e Move mode is similar to Copy mode, except that it masks the brushed area and moves the
original area to a new location.

Healing Brush modes cannot be changed once they have been applied; if you wish to change the
application in an area, you must select the old marker, choose Delete from the Tool Options bar, set the
new mode, and re-brush the chosen area.
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Healing Brush Options

25 v Opacity 100 v Mode Heal v Overlay Auto ¥ 69 Q

e Brush Size: Adjusts the overall size of the brush.
e Brush Feather: Adjusts the hardness of the brush.

e Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an
imperfection. Use a lower opacity to soften it.

¢ Mode: sets the type of healing that will be applied when brushing — Heal (content-aware),
Stamp (pixel-exact), Copy (content-aware) or Move (content-aware).

e Overlay: Sets the display of the markers designating retouched areas. Auto displays all the
markers in the photo, with the current marker highlighted in red and green, and the others as
gray. Selected will only display the current marker (in red and green); the other markers will
only be visible as you move over the photo with your mouse.

e Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots
more easily.

e Pressure Adjusts Size (gear icon): If you have a pressure-sensitive tablet, you can adjust the
size of the brush according to the pressure. Click the button to activate.

Transforming retouched areas

As noted, all applications of the Healing Brush are
non-destructive, meaning that you can adjust the
source and destination areas for each marker, and
you can delete markers by clicking on the appropriate
market and choosing Delete from the Tool Options
bar (or by pressing the Delete key).

You can also transform individual destination markers
in a photo by holding down the Option/Alt key (Mac/
Windows) and hovering over the area. When you do
this, a box will appear over the currently selected
destination marker. You can resize the selection

by adjusting the handles on the box; to resize
proportionally, hold down the Shift key. You can also
rotate the selection by clicking outside the box and

pressing the mouse key, or you can flip the selected Sl ecieo s bt s borsear it o

area vertically or horizontally by clicking the icons conjunction with the Healing Brush’s Copy or Move modes, you can
d th th b easily duplicate and transform individual subjects within your frame,
undernea € box. as shown by the copy of the pronghorn above..

o

When ou hold down the Option or Alt key and hover over the

PERFECT ERASER (RETOUCH GROUP)

The Perfect Eraser can be used to remove distracting elements and blemishes from your image.
It uses a content-aware algorithm that replaces the pixels with a natural-looking result within the
boundaries that are painted.

Using the tool is easy: paint over the area you wish to remove and release the mouse, making sure you
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cover the entire area. A red overlay appears where you paint. If the first attempt does not give you a
perfect result, paint over it again. You can also fine tune the area after applying the tool by using the
Retouch Brush (see below).

Perfect Eraser Options
Size 30 v 63 Q

The Perfect Eraser’s Tool Options bar consists of three options; brush size, a dust-spot overlay, and
pressure-sensitive tablet support.

The default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller by clicking
on the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your keyboard.
The maximum brush size is 500 pixels.

The Visualize Dust item displays a high-contrast overlay to help find and eliminate sensor dust spots.

If you have a pressure-sensitive tablet, select the Pressure Adjusts Size item, which is in the gear icon.
The gear icon also includes a Legacy option, which is solely used to preserve compatibility with previous
versions of Photo RAW.

RETOUCH BRUSH (RETOUCH GROUP)

Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the brush
on areas that contain spots or other imperfections, such as acne, sensor dust, power lines and
more. The tool looks at the neighboring areas in your image and fills in the brushed area with an
area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush
strokes. If you dab with the Retouch Brush and don't like the results, use the Undo command and try using
a smaller brush or vary your brush stroke and try again. The Retouch Brush is also great for retouching skin.

Retouch Brush Options

Size 150 v Feather 30 v Opacity 100 v 69 Q

e Brush Size: This adjusts the overall size of the brush.

e Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger
than 50 to blend and look natural.

e Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an
imperfection. Use a lower opacity to soften them.

¢ Visualize Dust: Changes the view to a high-contrast overlay, to help view sensor dust spots.

¢ Pressure Adjusts Size (gear icon): Click on the button to activate the sensitivity controls for
your pressure-sensitive tablet.
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CLONE STAMP (RETOUCH GROUP)

Use the Clone Stamp tool to replace an area of a photo with an area from a different part. Hold
down Option (Mac) or Alt (Windows) and click the area you want to clone from. Then click and
drag on the area you want to clone over and it will clone from the point you selected.

Clone Stamp Tool Options:

Size 125 v Feather 25 v Opacity 100 v 69 Q

¢ Brush Size: This adjusts the overall size of the brush.

e Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger
than 50 to blend and look natural.

e Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an
imperfection. Use a lower opacity to soften them.

o Pressure Adjusts Size: If you have a pressure-sensitive tablet, you can adjust the size of the
brush according to the pressure. Click the button to activate.

VIEW (ZOOM) TOOL

W This tool, which is the default tool selected when you open an image, adjusts the magnification
Q of the image in the Preview window. With the Zoom tool selected, click in the Preview window
View to zoom in and center the image at the location clicked. Hold down the Option/Alt key to
display the Hand tool, which lets you pan around the magnified image. You can also double-
click the Zoom tool in the Tool well to set the image to 1:1 (or 100%) magnification view, which shows
every pixel. This is best when examining small details.

ONI1 NoNoise Al User Guide Part 2: Using NoNoise Al 37



NoNoise Al Photo Information Panes

THE NAVIGATOR PANE

The Navigator pane presents a thumbnail view
of your image. The white square region marks
the image area that is visible in the preview
pane. You can pan your image by clicking and
dragging inside the square.

Levels History Snapshots

At the bottom of the Navigator pane are several
zoom buttons representing percentage zoom
views (100%, 50% and 25%). Click on one of the
buttons to change the view. Fit zooms to fit the current canvas size, while 100 zooms to 100%, displaying
the actual pixels. (When adjusting the noise reduction and sharpening options in the Detail pane, it is
recommended that you zoom in to at least 100%.)

THE LEVELS PANE

This gives you a color chart of the shadow,
midtone and highlight areas based on the image
RGB values (commonly known as a histogram). (A
This is useful to show areas within the image
that may be clipping. Clipping is when your
image contains pure blacks or white and can
signify loss of highlight or shadow detail.

History Snapshots

Red 229 | Green 235 | Blue 251

The left side of the histogram represents the

shadows, while the right represents the highlights. At the top of each end is a triangle. If the triangle is lit,
there is clipping on that side of the histogram. If you click on the triangles, you will activate the clipping
overlay on your image, displaying the areas that are clipped. Those areas with a blue overlay are pure black,
while the areas with the red overlay are pure white. You can turn the clipping view off again by clicking on
one of the triangles.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

NOTE: You can also use your mouse’s scroll wheel to pan and zoom inside
your photos. See “Using NoNoise with a Scroll Wheel” on page 20 for
specifics.
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THE INFO PANE

The Info pane displays metadata for the current
image in an easy-to-read format. This metadata

Nav History Snapshots

includes camera make and model; lens focal Sy W=

. . 58 mm (Sony FE 24-105mm F4 G 0SS)
length; capture date and time; file type; ISO 11/26/2021 5:23:16 PM
setting; shutter speed; aperture; and exposure 8640 x 5760 - 78.0MB - RAW

compensation.

1SO 6400

The Info pane also displays file-specific data,
including name, and image dimensions. If any of
the metadata fields are unavailable they will be left blank.

The Settings Applied section at the bottom of the Info pane is shows the operations that have been applied
to the current image. The Crop and Retouching items will be grayed out unless you have performed those
options during your editing session.

THE HISTORY PANE

The History pane tracks every adjustment made
during each image’s editing session. You can :
i DeathValley_20220305_7173.arw copy 1 - Masking Brush Stroke
use the History pane to walk back through your DeathValley_20220305_7173.arw copy 1 - Masking Brush Stroke
. DeathValley_20220305_7173.arw copy 1 - Masking Brush Stroke
edits, all the way back to the state of your photo  [irciam o ’

when you opened it for editing.

Nav Levels Info History Snapshots

Add Layer DeathValley_20220305_7173.arw copy 1
Content-Aware Fill
Adjust NoNoise Al

You can scroll through the list, and, if you click Open
on an item, NoNoise will “roll back” your edits to Revert

the spot you clicked. You can click up and down

in the list, and, as long as you don’t make any changes, the entire history is preserved. If you roll back to an
edit and make a change, the History pane “resets” from that point on, losing any of the edits you made after
the point you rolled back.

The History feature is not saved once you finish editing a photo.

THE SNAPSHOTS PANE

The Snapshots function lets you save a photo'’s editing “state” at any point in the editing process, so that it
can be returned to at a later time. When you create a snapshot, it saves all of the current photo’s edits as
they are in that moment. Once saved, you can get back to that state in the editing process at any time by
clicking on the snapshot’s name in the pane. You can also create multiple snapshots and move from state to
state by clicking on the appropriate snapshot in the list.

NOTE: Snapshots are only available when working with NoNoise Al in
standalone mode. When using NoNoise as a plugin from other editors,
snapshots are not saved.
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Snapshot basics

The top of the Snapshot pane for each photo will always have an item called “Original,” which is the original
state of the photo as it was first opened in NoNoise.

To create your own snapshot, go to the Snapshots tab and click the New Snapshot button. A window will
open asking you to name the snapshot; by default, it will be the current date and time, but you can enter
any descriptive text you would like. There is no limit to the number of snapshots you can create.

When you wish to return to the editing state defined by a specific snapshot, click that item in the Snapshots
pane. You can also move from snapshot to snapshot, which can be helpful for comparing edits. To then get
back to where you were at before you clicked a snapshot, choose Undo, or, if you've applied a number of
edits from that snapshot state forward, you can use the History pane to roll back to the pre-snapshot state.
(Alternatively, you could create a new placeholder snapshot, which would preserve that state, and return to
it later.)

Managing snapshots

There are a few snapshot-management options available, which can be called up by right-clicking on any
item in the Snapshots pane. These options include:

¢ New Snapshot: creates a new snapshot with the current editing state.

e Delete Snapshot: removes the snapshot permanently from the pane.

e Rename Snapshot: renames the snapshot.

New Snapshot...

e Update Snapshot with Current Settings: saves
the current editing state to the selected snapshot,
overwriting the previously saved state. Rename Snapshot...

¢ Create Version from Snapshot: not applicable in Update Snapshot with Current Settings
NoNoise Al.

Delete Snapshot

Right-clicking on an item in the Snapshots pane gives you a
list of management options for that snapshot.

NOTE: The individual Nav, Levels, Info, History and Snapshot panes can be
hidden from view and rearranged. See “Customizing the display and order of
Tabs and Panes 1” on page 18 for more.
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Resetting edits

The Settings menu offers four options for resetting aspects of your editing session with an image:
¢ Reset All Settings: This removes all adjustments made to a photo. (This option can also be
accessed from the Reset All button at the bottom right of the main NoNoise window.)
e Reset NoNoise Al Settings: Resets the Noise & Sharpening panel to its original state.
¢ Reset All Retouching Tools: Resets any retouching applied.

¢ Reset Crop: Returns the image to its original, uncropped size.

NOTE: The Reset settings work on the currently selected layer, not on the
file. If you are using Layers to selectively apply NoNoise in different parts of an
image, you must reset each layer individually.
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PART 3: EXPORTING IMAGES

When you're working with multiple images in standalone mode and you click Done, NoNoise Al
will present the Export window, which saves all of the files in that group based on select export
criteria you can customize. When working with single images, you can get to the Export window

M

Export

by clicking on the
More icon underneath the
Tool Well on the left bumper
panel.

The Export window is
separated into two panels:
Export Presets and Export
Options. The Options panel
contains specific types

of options—file renaming,
destination folders, file type
and more—that you can use
when you are exporting
images from NoNoise. If
you find that you are using a
specific set of options all the
time for your workflow, you
can create a preset and apply

that whenever you use Export.

The Export window is as
shown below. Note that not
all export options—Resize,
Sharpening, Metadata, and
Watermark—are applicable
for the standard, DNG-
based NoNoise workflow,
but are presented here for
completeness (they do work
if you wish to export versions
of your images in other file
formats, however):

0 Q® Export - 6 Photos

Export Presets

1200px JPG to Desktop
JPG sRGB IEC61966-2.1 90%
Desktop

Hide £ C

1200px Long Side @ 96 ppi
Copy Originals to Desktop

Original
Desktop

DNG to Same Folder

DNG sRGB IEC61966-2.1
Current Folder

TIF to ZIP on Desktop

TIF Adobe RGB (1998) 16-Bit
Desktop

F

G

H

Save Preset

Export Options

Naming

Presets v

Example: ISO_samples_2024_20230417_0724_Export.dng

Filename _Export

Extension Lower Case v

Destination
Folder Same Folder as Original v
Put in Subfolder

Existing Photos Keep Both v

Estimated Space Needed 1.7GB (175.8GB Available)

> Generate Subfolders

After Export:
Show in Finder
Create a ZIP Archive

Open in Adobe Lightroom Classic v

Run a Script

File Type

File Type DNG v

Estimated File Size is 219MB
Resize
Sharpening
Metadata
Watermark

J Reset

Add Token

Cancel

Export

A. Currently Selected Preset: The current preset (if used), will be represented with a selection
box around it, and the filled circle to the left of the preset name means that it will be used
when the Export button is pressed. To use the Export Options panel without any preset
applied, click at the bottom of the Presets panel, outside any of the presets in the list.

. Save Preset: Lets you save the current set of export options as a preset.
. Naming: Renames the exported file based on criteria added to the rename box in the panel.

. Destination: Lets you set the destination of the exported files. (required)

m O 0O @

File Type: Sets the file type for each exported file. (required)
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Resize: Adjusts the size for each image. (Not available when exporting DNGs.)

. Sharpening: Applies sharpening to the exported images. (Not available when exporting DNGs.)

I o m

. Metadata: Adds/removes metadata from the export. (Not available when exporting DNGs.)

Watermark: Lets you add a text or graphic watermark to an exported image. (Not available
when exporting DNGs.)

J. Export/Cancel: Starts the exporting, or cancels it and returns you to NoNoise Al.

Primary NoNoise Al Export Options

The Naming, Destination, and File Type export options are the primary panes you'll work with when
exporting from NoNoise Al. Of these, only Destination and File Type are required. The Naming pane
lets you rename the images being exported, which can be helpful when you wish to add a shoot name or
specific image metadata to the file name during the export process.

NAMING

The Naming pane gives you extensive options for
creating customized filenames using tokens in the
entry box inside the panel, as well as with custom
text entered directly into the entry box. You can use
any combination of tokens and text in the entry box,
and the Example label directly above the box will
display what your new filename will look like, using Extension Lower Case v Add Token...
the first item in the export group.

Presets v
Example: joshua_tree_1964_20230321.psd

joshua_tree_  Filename Number Suffix _ Date (YYYYMMDD)

You have extensive controls for renaming an exported group of images
from NoNoise, including text (here denoting the shoot location), the
number of the file (as saved by the camera), the year it was shot, and a

To use this feature, click the control circle to the left sequence number.

of the label in the panel. Add any custom text, or

click the Add Token pop-up menu to add tokens based on information associated with the image, including
filename data, date and time information, and associated metadata There are four submenus in the Add
Token menu:

¢ Filename, which includes options for using the original filename, number suffix (taken from
the image as recorded by the camera) and enclosing folder name.

o Date/Time, date (year, month, day) and time data that can be combined in various ways.
e Sequence, for batch processing of images.

e Metadata, which lets you add specific EXIF and IPTC metadata to the filename.

To build a rename sequence using tokens, click on the Add Token button, and choose the appropriate token
from the pop-up menu. The token will be added as a shaded item in the text field, and the Example item
above the text field will show a sample of a renamed file using the current set of tokens and custom text.
To change an existing token, click on the down arrow on the right of the token, which will display the full
set of tokens. To delete a token, double-click on it and press the Delete key.

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end
of a token (or in between tokens) and add spaces, dashes, underscores and any other text you wish to be
included in each renamed file. Each change you make will be updated automatically in the Example label.
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The Presets pop-up menu at the top of the Rename window includes a set of common token combinations
that you can use as a starting point. You can also create your own batch-rename presets: build the rename
options you wish, and choose Save New Preset from the bottom of the Presets menu. You can also update
an existing preset and delete presets from this menu.

Because the Rename process is not undoable, make sure you use the Example field to check that your text
and token combinations give you the filenames you expect for your batch process, and adjust as needed.
When you're sure, click Apply, and NoNoise will rename all of the files.

NOTE: A complete list of the tokens used in the Rename window, with
explanations, can be found starting on page 50.

DESTINATION

The Destination pane is where you set the desired
location for the exported images. At minimum, a A @
destination folder is required, but the pane has a GG

number of additional options for tuning the location: Existing Photos  Keep Both
Estimated Space Needed 1.4GB (674.2GB Available)

Destination

e The Folder pop-up lets you choose the
same folder as the original images, another v © Generate Subfolders
specific folder, or, you can set it to ask for Presets YYYYMM-DD ~
a destination every time, which is helpful
when you're using an export preset.

Example: /Users/rick/Desktop/2023/03/21

Year (YYYY) Month (MM) DEVA(D))

e Checking the Put in Subfolder option will

create a new folder—specified by what you Add Token..
enter into the option’s text field—and will After Export:
place the exported files in that folder. Show in Finder
o 4 . Create a ZIP Archive
¢ The EXIStIng PhOtOS pop-up IS fOI" thOSE Open in Adobe Lightroom Classic v

times when there might be a naming Run a Script
conflict within the destination folder.
Replace will overwrite the file with the
new one being exported, Skip will leave the destination file alone and not export the new
file, and Keep Both will add a number ‘1’ to the end of the filename of the exported file,
preserving both files.

e Generate Subfolders will further subdivide the export based on the exported file's metadata,
creating subfolders as necessary—or, if the folders exist, placing the exported file into the
appropriate subfolder. This is often used when people wish to store images in a year/month/
day file structure, or some similar metadata-driven scheme, and are working with a large
number of files.

o After Export lets you determine what to do when NoNoise Al completes the exporting
process. Options include displaying the image location in the MacOS Finder or Windows
Explorer, to create a ZIP archive of the exported group, to open in another editing application,
or to run a script.
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FILE TYPE

Like Destination, File Type is the other required

. X File Type
element for using the Export feature, and NoNoise _
File Type Photoshop v
Al can export in DNG, PSD, TIFF, JPG and PNG Drare ProPhotoRGB v Bit Depth

formats. With the exception of DNG, each file Flatten Layers
format has options that you can set in the pane. (it e Sre s AN

With the exception of DNG and PNG, each file format has specific options in the pane:

¢ Original includes options for embedding metadata and saving an ON1 sidecar file with the
exported images.

e JPEG includes options for JPEG quality and for attaching a color profile.

e Photoshop includes options for attaching a color profile, bit depth, and whether to flatten
any layers in the original image.

e TIFF includes options for image compression (none, LZW or ZIP), attaching a color profile, bit
depth, and to preserve transparency.

¢ As noted above, DNG and PNG have no additional options.

As noted in “NoNoise Al Workflow Recommendations” on page 2, the optimal export format for
NoNoise Al is DNG, which provides the best tonal and color fidelity to the original raw file. After that, 16-
bit PSD and TIF files are the best option for editing.

Secondary Export Options

The other Export panes, Resize, Sharpening, Metadata and Watermark, are designed for those times when
you wish to export versions of your images in other file formats. Because you can export files using more
than one preset, you can do things like export DNGs for full edits in your chosen workflow app, and JPGs
for instances like sharing on social media, performing light editing in other apps, and more. (See “Exporting
and Export Presets” on page 49 for details on using presets.)

RESIZE

The Resize pane lets you adjust the finished
dimensions of the exported photos, using the

Resize

Resize to Dimensions v

patented Genuine Fractals technology found in ON1
Resize. It has seven options for export: Dimensions, Width 9504  Height pixels v @
Long and Short Edge, Width and Height, Megapixels ey 300 ERRGL Dimeision sy
and Percentage. Each option has a different range ot Enlarge = Rotate to Match Photo

of settings, and all have a setting for resolution (in
pixels per inch, or ppi), as well as a Don’t Enlarge
option, which, when set, will not upscale a file past its native image dimensions (but will still export the file).

Common Sizes v

Method Bicubic v

The Resize pane, with the Dimensions option open.

The Dimensions option is the most complex of the six Resize options, letting you set the exact pixel
dimensions of the exported files, in terms of width and height. This option is best for when you are
exporting single images, when all of your exported files have the same aspect ratio and orientation, or
when you wish to fit the exported images to an exact size.
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The Common Sizes pop-up menu at the top of the pane options lets you set the final dimensions to any of a
broad array of common paper, photographic ratio, square and video formats. You can also create your own
specific sizes for re-use via this menu.

Click the lock icon to resize the images proportionally as you enter either the width or the height, or, if

you wish to fit the images to an exact width and height, click the lock icon to turn it off. If an exported
image doesn’t exactly fit the dimensions you set for Width and Height, Export will do one of two things,
depending upon whether you have Fit in Dimensions or Fill Dimensions set in the pop-up to the right of the
Resolution box.

¢ Fitin Dimensions fit the exported file inside the boundaries of the width and height settings.

¢ Fill in Dimensions zoom the exported image to completely fill the boundaries of the width
and height settings, essentially cropping the exported image. If the image’s aspect ratio is
different from the width and height settings, the image will be filled from the center.

The Dimensions options include one more setting, Rotate to Match Photo, which, when checked, will rotate
an exported photo to maximize its orientation. For example, if you exported a group of images to fit a
landscape orientation (longer width than height), any image that was in portrait orientation (longer height
than width) would be rotated during export.

The remaining options in the Resize pane include:

Long Edge and Short Edge are useful when you want to lock one edge to a specific length or width and
don't care about the sizing of the other edge. Simply choose which option is the important one for your
photos, enter the dimension, and Export will resize your images proportionally based on the chosen setting.

Width and Height will resize all of the images proportionally to the width or height defined, regardless of
orientation. Exporting photos with different orientation will result in the width or height of every image
being the same, depending upon the setting chosen.

Megapixels will export images to a specific megapixel count, while Percentage will enlarge or reduce the
size of the exported images. Percentages below 100 will reduce the image, while those above 100 will
enlarge the image.

SHARPENING

The Sharpening pane has two modes, Sharpen For
and Manual. The Sharpen For pop-up menu lets
you choose from six options, based upon your final
intent. There are four options designed for print rmount
output, Glossy Paper High and Low, and Matte High —
and Low, and two option for display output (for Radius

social media or online sharing), Screen High and Low.

Sharpening

Sharpen for Screen Low v

v Manual

Threshold

The Manual setting provides a bit more control
over the output sharpening, letting you adjust the
Amount (overall strength), Radius (detail) and Threshold (masks out areas that shouldn’t be sharpened
based on contrast).
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METADATA

The Metadata pane lets you set which pieces of
metadata are exported—or not exported—with the
images in the export set. You can choose to export
all Metadata or by clicking the control circle to the
right of the All Metadata label. If you click that label
off, you can then select which metadata items you
wish to save by clicking the appropriate label.

When checked, the Remove Unmanaged XMP

Metadata

Presets RL copyright v

All Metadata Camera Info
Keywords IPTC - Contact
Description IPTC - Content
Ratings Labels IPTC - Image
GPS IPTC - Status

User Comment IPTC - Copyright

Remove Unmanaged XMP

button only exports metadata that ON1 recognizes as standard metadata fields;
any unmanaged image metadata from other apps will not be included.

WATERMARK

The Watermark pane adds either text- or graphics-
based watermarks to an image, with options for
size and positioning, opacity, font type, and more.
You can import your own logos and save either
watermark type as a preset for frequent use.

The Watermark pane also gives you a representation
of your chosen watermark (on the first image in your
export group), so you can adjust the parameters of
the watermark precisely.

To create a new watermark, turn on the pane by
clicking on the control circle to the right of the label.
Choose either a preset from the Presets menu or
click on the Add Watermark button in the lower
right of the pane and choose either Text or Logo
from the pop-up menu. Once you've selected a type,
the bottom of the pane will open with settings for

the chosen option. If you change your mind, click the

Cancel button to the right of the Logo or Text labels.
Using graphics-based watermarks

The Logo section of the Watermark pane lets you
use either watermark files imported via the Extras
Manager (see page 16), which will be displayed

in the File pop-up at the top of the Logo section, or
by clicking on the Import button to the right of the
menu (which will add them to the menu).

Watermark

Presets Made with ON1 v

v Logo

Appearance:
File C9— Made_with_ON1 v

Size
—e
Inset
—e
Opacity

Add Watermark

Import...

. )

Position:

Repeat Image

Use the Position grid at the bottom of the pane to place your watermark, and use the Size and Inset sliders
to move it within the area chosen. The Opacity slider adjusts the transparency of the watermark on the

final image.
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The Repeat Image button will repeat the logo graphic rightward across the image from the location chosen
in the Position grid. If you wish to repeat the watermark across the entire image, choose one of the sections
on the left side of the Position grid.

When working with graphics-based watermarks, make sure your watermark file is sufficiently large for
your usage. For example, if you want it to appear 2 inches wide on a 300-ppi image, your watermark needs
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting

to social media—it needs to be the same size as what you are exporting for the web, typically over 1000
pixels. Using a watermark file that is too small will create a pixelated watermark appearance. And, because
most watermarks are overlays on top of an image, these files are usually PNGs with areas of transparency,
although JPGs can also be used, depending on the logo.

Using text-based watermarks

When creating text-based watermarks, the Text
section of the pane has an entry box for your
watermark text, a font selection area, and the same
Appearance and Position options found in the Logo
section.

The text entry box can contain multiple lines of
custom text, and has the same token-based naming
options found in the Naming pane (discussed on
page 50), which can be helpful when exporting
informational slides or for other data-driven uses.

Add Watermark

You can set the font from the pop-up menu, and
the font color by clicking the swatch on the left side v Text
underneath the font name. The text style can be Birds of Prey Center
set to bold, italic or underline, and the alignment to Charleston, SC
left, center or right. If you'd like to add a background
color to the text box, turn on the Color Fill button

on the right side of the pane. Add Token
Font:

Use the Position grid at the bottom of the pane Open Sans v

to place your watermark, and use the Size and B I U= Color Fill

Inset sliders to move it within the area chosen. AL
The Opacity slider adjusts the transparency of the Stz
watermark on the final image.

Saving watermark presets

Both watermark types can be saved as a preset

for re-use later. To save a preset, adjust your Logo

or Text settings as desired, and choose Save New

Preset from the Presets menu. If you wish to adjust With text-based watermarks, you can not only create simple, single-line
L. . ' . watermarks showcasing your business, but you can also create

an existing preset at a later time—with a new |0g0 data-driven watermarks (using tokens) for presentations and the like.

file, for example—choose the appropriate preset

from the Presets menu, make your changes, and choose Update Preset with Current Settings from the

Presets menu. You can also rename and delete watermark presets from this menu.
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Exporting and Export Presets

The Export window has been designed to offer as much or as

little complexity as you would like. At its simplest, you can set the
Destination and the File Type to your desired settings, leave all of
the other panes alone, and click Export. NoNoise Al will remember
your last Export setting—including anything you did in the Naming
pane—the next time you export, so you don’t have to worry about
which settings need to be set, and which ones don’t. You can use
the Show/Hide buttons in the title bar of each pane to display only
those settings you want to see.

Once you have your settings the way you'd like, you can save
them as a preset by clicking the Save Preset option in the Preset
panel on the left. Then, when you click that item in the Preset
panel, the Export Options will be set to the specifications of that
preset.

The Export Presets panel will display a list of the currently
available presets. If you have selected a preset, it will have a
selection box (in the app’s accent color) around it, and if the
control circle is filled, the preset is on, meaning that clicking the
Export button will export using that preset.

By default, each preset will have two lines of explanatory text
underneath the preset name, displaying the file type—DNG, PSD,
TIFF—and the Destination information. This can be helpful when
you're scanning presets for a specific destination, but you can also
collapse the preset to it's title by clicking the Hide button in the
title bar.

Other notes about presets:

Export Presets

2000px JPG to Desktop Hide

JPG sRGB IEC61966-2.1 90%
Desktop
2000px Long Side @ 300 ppi

2000px DNG to same folder Hide

DNG sRGB IEC67966-2.1
Desktop
2000px x 1334px @ px 72

2000px JPG to same folder Hide

JPG sRGB IEC61966-2.1 100%
Current Folder
2000px Long Side @ 72 ppi

Copy Originals to Desktop

Original
Desktop

DNG to Same Folder

Original
Current Folder

DNG to Same Folder

JPG to Subfolder

TIF to ZIP on Desktop

Save Preset

e While the batch-export process is designed for when
you're using NoNoise Al in standalone mode, you can
. . . . folder. If you don’t wish to see that, click the
export an individual image directly from NoNoise at any Hide button to collapse the view to just the
time while you're processing it. Just click the Export icon preset title.
in the main window.

All presets include an informational view that
lists the export file type and the destination

e If you click on a preset and change the settings in the various panes in the Export Options
panel, those changed options will become part of the new preset.

e |tis possible to export more than one preset at a time. Every preset in the Presets panel that
has the control circle set to On (filled) will be included in the export operation. This might
be helpful to create backups on another disk, for example, or to build proxy versions for use
while the original is being edited.
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About Export’s File-Naming Tokens

When using the Naming option in the Export window, NoNoise includes a broad set of tokens that you can
use as part of the strings to build complex file names, in conjunction with any custom text you wish to
enter. These tokens draw on image metadata, including filenames, dates taken, and EXIF and IPTC
metadata fields, and can be used in any number of combinations.

To build a rename sequence
using tokens, click on the Add
Token button, and choose the
appropriate item from the pop-up
menu. The token will be added

as a shaded item in the text field,
and the Example item above the Extension Lower Case v/ Add Token...
text field will show a sample of
a renamed file using the current set of tokens and custom text. To change an existing token, click on the
down arrow on the right of the token, which will display the full set of tokens. To delete a token, double-
click on it and press the Delete key.

Presets *Date - Folder Name - Original File Number
Example: JT_workshop_230417_nonoise 2024_0724.dng

JT_workshop_ Date (YYMMDD) _ [Folder Name _ Filename Number Suffix

Custom text can be added anywhere in the entry field. You can click the cursor at the beginning or end
of a token (or in-between tokens) and add spaces, dashes, underscores and any other text you wish to be
included in each renamed file.

There are four categories of tokens, each with their own set of options: Filename, Date/Time, Sequence,
and Metadata. A description of each is listed below.

FILENAME

The Filename tokens use information from the
filename or the enclosing folder that the file resides

in. There are three options, Filename, which adds the Sequence Number - Folder Name
Metadata 3

Filename
Date/Time . Filename Number Suffix

current filename of the file being worked on; Filename
Number Suffix, which takes the index (shot) number
from the original raw file, if available; and Folder Name, which grabs the name of the folder in which the
renamed (or imported) file resides.

DATE/TIME Filename

Date (Month DD, YYYY)

. . . . Sequence Number Date (DD Month, YYYY)
This submenu consists of 17 combinations of date and Metadata Date (YYYYMMDD)
time data, as taken from the image’s metadata. There Date (DDMMYYYY)

! ) o7 Date (YYMMDD)
are prebuilt date and time combinations (20220104, for Date (DDMMYY)
example, for a year-month-date token) in the list, or your Year (YYYY)

) oo Date (YYYY-MM-DD)
can build your own combinations out of the subtokens Year (YY)
listed in this menu. Month (Month)
Month (Mon)
Month (MM
Year data can be presented in either 4- or 2-digit D:yn(Dé) )
numbers, and Month data can be presented in month Time (HHmmss)

Time (HH)
Time (mm)
Time (ss)

number, full name, or 3-letter abbreviations.
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SEQUENCE NUMBER

The Sequence Number tokens come into play when
exporting, importing or renaming a group of image files.
There are essentially two tokens here, Sequence and Total,
with options for padding zeros into each item. Sequence will
take the group of images being worked on and, starting with
the first item in the selection, will start at 1 and increment
by one as each image is processed. The Total token will
always be a single number—the number of items in the group
being processed.

Filename
Date/Time

Metadata

The combination of Sequence and Total tokens lets you
create strings like ‘filename_07 of 22’ as part of the new filename.

METADATA

This submenu has five items, each with its own submenu.

All of the items create the chosen token based on the
embedded metadata for each image being renamed,
imported or exported. The specific text pulled from the
Camera and IPTC tokens will be visible in the Metadata
pane’s EXIF (for camera-specific data) and IPTC (for IPTC
data) tabs. The Ratings and Labels tokens are taken from any
you have applied in NoNoise.

Filename
Date/Time
Sequence Number

NOTE: If there is no information in the specified Metadata token, it will be
ignored during processing.

Camera

The Camera submenu includes 21 items, all of which are
directly taken from an image’s EXIF data. Not all cameras
capture all of the items listed, but most of them save essential
items like exposure information, focal length and more.

Ratings Labels
IPTC-Contact
IPTC-Content
IPTC-Image

Ratings and Labels

The three tokens in the Ratings and Labels submenu (shown
below) pull information from any rating, label and like
information stored with images opened in NoNoise.

Camera

IPTC-Contact
IPTC-Content
IPTC-Image

Sequence
Sequence

1)
01)
Sequence (0001)
Sequence (00001)
Total (1)

Total (01)

Total (001)

Total (0001)
Total (00001)

(

(
Sequence (001)

(

(

Camera
Ratings Labels

IPTC-Contact
IPTC-Content
IPTC-Image

Dimensions
Exposure

Focal Length
Exposure Bias
Shutter Speed
Aperture

ISO

Flash

Exposure Program
Metering Mode
White Balance
Focus Distance
Make

Model

Serial Number
Author

Lens

GPS

Altitude
Direction

User Comment
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The Rating token will add the number of stars an image is rated, while the Label token will add any color
label information (red, yellow, green, blue, purple), and the Likes token will add Liked, Not Set, or Disliked to

the image name.

IPTC Metadata Tokens

IPTC (International Press Telecommunications Council) is an industry-standard metadata format, and offers
much more detailed metadata information than EXIF. It historically has been used by journalists and stock
photographers to catalog and tag photos, as well as add copyright information, captions, and other data.
There are nearly 30 different tokens in the IPTC metadata submenus, which are divided into Contact,
Content, and Image. You can use these tokens if you know that an imported file has stored IPTC Metadata

information.

Camera
Ratings Labels

Camera
Ratings Labels
IPTC-Contact

Creator
IPTC-Content Job Title
IPTC-Image Address
City

Keywords
IPTC-Image Headline

Subject Code

Description

Description Writer

State/Province
Postal Code
Country

Phone

Email

Website

Camera
Ratings Labels
IPTC-Contact
IPTC-Content

Intellectual Genre
Scene Code
Sublocation

City

State/Province
Country

Title

Job Identifier
Instructions
Creditline
Source
Copyright
Usage Terms
Copyright URL
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PART 4: WORKING WITH LAYERS

ON1 NoNoise Al 2024 (ISO_samples_edit_20180226_0408-2.dng @ 33.6% 16-bit)

iormal

3 DV_20180225 0408

Noise & Sharpening

NoNoise Al T

The Layers feature inside ON1 NoNoise Al 2024 lets you selectively apply noise reduction and sharpening settings selectively to different areas of an
image, using layer masks. For example, you could create a layer that applied NoNoise settings to the sky in an image, while another layer applied
different settings to the foreground.

ON1 NoNoise Al’s Layers functionality—available in both standalone and plug-in modes—lets you use
masking techniques to apply separate noise reduction and sharpening settings to different parts of an
image. For example, you might wish to apply stronger noise reduction to the shadow areas of a photo, while
applying less to a sky. Or, you might want to apply extra sharpening to an area with detail, but have no
sharpening at all in smooth areas. By using a combination of NoNoise’s masking tools and layers, you can
easily paint Noise & Sharpening settings in or out of portions of your images.

Sample NoNoise Workflow with Layers

When thinking about selectively applying noise reduction in a single image, it is usually because you

have two very different areas in an image, each of which require slightly different treatments. By using
layers and masks to separate the two sections, you can easily apply NoNoise's advanced noise-reduction
technology at different levels, providing better tonal range in your raw image, before you start working in
your chosen photo editor.

To achieve this, you create a copy of the original photo as a separate layer, and then use NoNoise's masking
tools to paint in (or out) different settings. When you are finished, NoNoise Al merges the layers in the file
into a finished DNG, using the Details settings you created for each layer.

What follows is a typical workflow, using the image shown at the top of this page.
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Once you've opened an image that requires selective application of noise reduction, perform the basic
steps as outlined in “Processing Single Images Inside NoNoise Al” on page 22. Make your adjustments,
focusing on one of the sections that you wish to selectively apply NoNoise Al.

In the image below, we want the foreground hills to show a bit more detail, but we don’t want to get
sharpening artifacts in the sky. So, as we work with the first adjustments in the Details pane, we pay
attention to the hills, moving the sliders to let the tiny details pop a bit.

Noise & Sharpening

NoNoise Al  Tack Sharp Al Both

o Apply

Auto On

In the initial layer, we'll pay attention to the sky. We won't worry about the foreground rocks, which are a bit soft. We'll use a separate layer to paint in
TackSharp settings.

Once you have your first layer set the way you like it, choose Duplicate Layer from the Layer menu. This
gives you a copy of the first layer, including that layer’s Details settings. Next, using the appropriate
masking tools, you'll create the mask, in essence ‘removing’ some of the image’s pixels from that layer.

Blending Masking

Mask Al Rel

Using the Al Quick Mask tool, we masked out the sky—shown here using the View Mask option, which displays a red overlay—so that our TackSharp
adjustments will only apply to the sky.
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For this image, we've used NoNoise’s Al Quick Mask tool to separate the sky from the foreground. In
essence, we've masked the foreground out of this layer, which means that the bottom layer’s Details
settings—which were adjusted based on the foreground—show through the combined image.

Now, any Details adjustments we make on this layer will only affect the sky, as shown below.

We can still fine-tune each layer’s settings, and even adjust the masks, if necessary. Once we're happy with
the results, clicking the Done button in NoNoise Al will merge the settings from the two layers into the
exported DNG file, giving us a fine-tuned final image, ready for editing in our app of choice.

Noise & Sharpening

eAl Tack Sharp Al Both

o Apply

Tack Sharp Al Deblur

With our layer only targeting the rocks, we can now apply TackSharp Al to that area, which won’t touch the masked sky.

The rest of this chapter will walk you through the specifics of both the Layers pane, the masking tools, and
tips for achieving the best masks.

Working with the Layers Pane

The Layers pane has three sections:

A. Layer Blending Mode and Opacity: Layers
Changes the blending mode, and
reduces the opacity of the currently
selected Iayer. mam death valley foreground

Blend Screen v Opacity 58 v

B. Layers: All of the layers in your P £3 Dv.20180225.0408
document are listed here, with a
thumbnail of the layer contents and the
layer mask (if there is one); the currently
selected layer has a bold name.

C. Layer Tools: The toolbar at the bottom of the Layers pane includes buttons for performing
basic layer operations (described in more detail below).
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A layer’s visibility can be turned on or off by clicking the button to the left of the layer thumbnail. When
turned off, the layer has no effect on the composite image.

LAYER PANE TOOLBAR

The layer commands in NoNoise can be accessed via the
Layers menu and a pop-up menu that you get when you
right-click on any layer, or choose the Pane options pop-up

menu on the far right of the layer name. The toolbar at the 6&] G
bottom of the Layers pane, however, contains the basic

commands you need when working with layers. From left,
the icons represent:

e Duplicate Layer: Makes a duplicate of the current layer.
e Delete Layer: Deletes the currently selected layer.

e Merge Layer: Merges the currently selected layer with the one directly beneath it in the
Layers stack.

Other layer commands, available via the Layer menu or pop-up, include:
e Reset Layer Properties: Deletes any layer masks you have made to the current layer. To

reset Details settings on a layer, click the Reset Layer button at the bottom right of the main
window.

e Merge Visible: Merges all of the visible layers—ones with the layer visibility status set to on—
in a file into a single composite layer, with all of the merged layers’ effect applied.

¢ New Stamped Layer: When you have the top layer in the stack selected, this option will
create a new composite layer at the top of the stack, with all of the layers’ effect applied.

¢ Align Visible Layers: This will align the visible layers, based on the content of the layers. (Not
really applicable in NoNoise Al, since your layers will essentially be copies of one another.)

Duplicate Layer

I3 men on bench cuba

Delete Layer

Reset Layer Properties
Merge Layer

Merge Visible

New Stamped Layer

Align Visible Layers

The Pane options pop-up menu is available when you hover over the far right of a layer’s title.

Changing Blending Modes

Blending modes determine how the selected layer blend with the layer(s) below it. The default blending
mode is Normal. This maintains the full opacity of the upper layer. Layers also supports many other
blending modes which can be used to alter the brightness, contrast and color of the image. Blend modes
are changed via the Blending tab of the Properties window. See “Blending Modes” on page 74 for
detailed information on this feature.
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Layer Masks

If you use any of the masking tools, a layer mask will be created automatically. Clicking on the layer’s mask
icon will display mask options, and you can use all of NoNoise’s masking tools to create or modify layer
masks, including the Mask Al feature (see “Masking control options” on page 71). You can also copy and
paste layer masks via the Mask options section or via the Mask menu. See “Masking Basics” on page 70
for more on using NoNoise’s masking tools.

Masking Tools

ACCESSING AND USING TOOLS

To access a tool, click on the tool or use the shortcut key. When selected, the cursor will change, and you
will see a set of options for the tool in the Tool Options bar above the Preview window. If the selected tool
is part of a tool group, you will see the other tools in that group, on the left side of the Tool Options bar.

Mode Paint Out v Size 150 v Method Hair/Branches v {3

Each tool in NoNoise has an Options Bar, where you can adjust the settings for that tool. Shown here are the options for the Refine Brush.

ADJUSTING TOOL SIZING PARAMETERS

When using any of the tools that have Size and Feather options, you have multiple ways to adjust those
parameters:

¢ In the Options Bar for each of those tools, you can use the slider in the Size and Feather
fields to increase or decrease the amount.

e You can use the left and right bracket keys on your keyboard — ‘[ “and ‘]’ — to adjust the
size; additionally, hold down the Shift key to adjust the feather.

e You can also use your mouse’s scroll wheel. Press Command-Option (Mac) or Control-Alt
(Windows) and scroll to change the brush size. To change the feather, press Option-Shift
(Mac) or Alt-Shift (Windows).

¢ You can also use your pressure-sensitive tablet, if you have one. Settings to turn that option
on will be found in the Tool Options bar’s Gear menu for the tool.

NOTE: More information about the different ways that you can use your
mouse’s scroll wheel can be found on page 20.
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MASKING BRUSH (MASK GROUP)

When you select the Masking Brush, your cursor changes to look like two concentric circles,
one representing the inner hard edge of the brush, and soft outer, feathered edge of the brush.
At the center of the brush is either a plus or minus. The plus means that you are painting “in”
that layer’s adjustments, while minus means the brush mode is set to paint out.

Masking Brush Tool Options

D Size 900 v Feather 50 v Opacity 100 v Paint Erase ‘/

The first icon is for the Masking Brush Options. Clicking on that displays a pop-up menu that contains all of
the options available for the tool (see page 59 for more). The five remaining items in the options bar are
the most common tasks used with the Masking Brush, and include:

Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at
high magnification for precise work, and a large brush at fit to screen for general work.

Feather: You control the amount of feathering—or hardness—of the brush by using the
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush
in Fit to screen mode for general work. You can visually see your feather by watching the
outer concentric circle of the brush tool.

Opacity: This controls the transparency of the brush, and ranges from 1 to 100 percent. You
use a high opacity to paint quickly and hide large areas. You use a lower opacity for blending
areas together or for subtle work. You can also control the opacity with a pressure-sensitive
tablet, or by pressing Option (Mac) or Alt (Windows) and one of the number keys on your
keyboard. Each number represents an opacity percentage from 10% (1) to 100% (0).

TIP: Think of the opacity as the shade of gray you are painting onto your mask.
White in a mask represents 100% of an effect and black (0%) represents no
effect, and opacity settings in between will show a percentage of the effect.

Paint Mode: There are two modes, Paint and Erase, and they control whether you are
painting in (restoring the effect) or painting out (hiding the effect), respectively. You can tell
your current mode by looking at the plus or minus icon in the center of the brush. If the icon
is minus, you are painting out (Erase), and if the icon is a plus, you are painting in (Paint). You
can change the mode in the Tool Options bar, by pressing the X key, or by holding down the
Option (Mac) or Alt (Windows) key temporarily.
To invert the mask (turn it from black to white), in order to paint a filter’s effect into your

image choose Invert Mask from the Mask Properties window.

Perfect Brush: The Perfect Brush incorporates an automatic edge-detection
technology to help create precise selections and masks. When you turn the
option on—by clicking on the Perfect Brush icon in the Options bar—the Masking
Brush collects the colors under the center of the brush and applies the effect Perfect Brush
only to those colors. icon.
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Masking Brush Options menu

The Masking Brush Options pop-up menu has six sections, Styles,
Properties, Shape, Perfect Brush, Manual Spacing and Pressure:

The Style pop-up lets you save the current brush state for use at
another time. Selecting a saved item from the menu will open that
saved brush'’s characteristics.

The properties section mirrors the Size, Feather, and Opacity options
in the main tool options bar, as well as the current Paint Mode setting.
Two additional options are also available, Flow and Angle:

e Flow: The rate at which the brush is applied, up to the
Opacity setting. With a low flow number, as you brush
back and forth, the brush color will build up to the Opacity
setting. At 100, the brush stroke is applied at the Opacity
setting.

e Angle: This sets the angle of the current brush shape. For
the default, round brush shape, this setting has no effect;
it is more useful when working with custom brush shapes
(see below). You can also rotate the brush shape by pressing
Shift-Option (Mac) or Shift-Control (Windows) and the left
or right bracket keys (‘[‘ or T').

The Shape menu displays a list of all custom brush shapes in your
library. The top item in the list is the default, round brush, which is the
standard brush for working with masks. Custom brush shapes are not
really applicable in NoNoise's limited editing capabilities.

You can tune the Perfect Brush settings via the Threshold and
Transition options:

e Color Threshold: This option lets you control the balance
between keep and drop colors, based on the area you are
working on. For example, you may want the Perfect Brush
to be very precise and only paint away very similar colors,
while at other times you want it to paint away a broad range
of colors in the same neighborhood.

e Transition: This slider controls the feather of the Perfect
Brush based on color. To create a soft edge, increase the
transition. To create a harder edge, decrease the transition
amount.

When checked, this sets the spacing of the brush tip as you apply a
stroke.

NoNoise supports pressure-sensitive tablets with the Masking Brush.
You can enable pressure sensitive controls for the brush size, brush
opacity, or both simultaneously. To turn this support on, click on the

Masking Brush Options

Styles

Style Default* ~

Properties

Size
—
Feather
ﬁ
Opacity
—
Flow 100
—
Angle ]
@
Paint Out v

Shape

Eyelashes

Perfect Brush

Color Threshold
=9

Transition

—e

Manual Spacing

Amount

—

Pressure
Pressure Adjusts Size

Pressure Adjusts Opacity
® 09
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gear icon in the Tool Options bar. You can activate pressure sensitivity for both size and opacity by clicking
the appropriate buttons in the drop-down menu.

GRADIENT MASK

The Gradient Mask is used for blending masks and layers by creating radial, gradient and
reflected gradient mask shapes. It works in a similar manner to the Adjustable Gradient tool
in the Local Adjustments pane. The mask goes from dark to light in tone, applying more of the
adjustment where the gradient is lighter, and less of the adjustment where the gradient’s tone
is dark. The most common use of gradient masks is to darken the sky in an image, while preserving the
brightness of the foreground, similar to using a gradient filter on your camera lens, or to adjust the effect of
a filter mask in Effects.

To apply a standard gradient to a filter in Effects, a local adjustment, or a layer, click on the Gradient Mask
in the Tool well, then click in the image roughly where you wish the gradient to go. You'll see the outline
of the gradient, which is called a bug. You can use the handles on the bug to move your gradient around,
increase or decrease the length of the gradient, or rotate it. You can also create (and delete) multiple
masking bugs.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Gradient Mask Tool Options

Preset Linear Top v Shape Gradient v Opacity 100 v Color Range 40 v

e Preset: The preset pop-up includes six settings for the bug’s mask (vignette, strong vignette,
top down, bottom up, and linear left and right), and changes the current bug (if there is one)
to match the preset.

e Shape: The shape pop-up controls the shape of the
bug. In addition to the standard Gradient and the
Reflected Gradient, there are two radial shapes:

Reflected Gradient

Center, which puts the light tones at the center Linear Bottom

and the dark tones on the outside of the mask, Linear Left

and Edges, which sets the gradient in the opposite Linear Right

direction The Preset (left) and the Shape (right) options for the
: Gradient Mask tool.

e Opacity: Sets the maximum density of the mask.

e Color Range: When enabled, this detects the color under the gradient and applies the mask
to only that color range. The higher the number, the wider the range of color that is selected.

e Add: Adds a new gradient using the current settings.
e Delete: Deletes the current gradient.

e Reset: Resets the mask on the layer completely. This removes all gradients and clears any
brushing that has been done.
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Manipulating a gradient mask

Once you've added a gradient to an image, you can
modify it easily by accessing the following parts of the
gradient overlay:

e To move a gradient, click on the large circle
at the center of the gradient and drag.

e To resize a radial gradient, click and drag on
the solid line.

e To adjust the feather (or hardness) of the
mask, click and drag along the dashed line.

e To rotate the mask, click on the smaller
circle near the center of the gradient and
drag it up or down.

Working with multiple masking bugs

You can have up to six masking bugs per layer. Each bug is re-editable. To add another masking bug, press
the Add button or click outside of the current bug while the Gradient Mask tool is selected.

Only one masking bug may be adjusted at a time. You will see the overlay controls for the active bug while
your mouse is over the preview area. Inactive bugs are marked with a small circle; to select an inactive bug
clicking on this small circle marker.

Masking bugs are subtractive. Each bug hides more and more of the current layer. When masking bugs
overlay each other they may hide more of the layer too. You can always use the Masking Brush to override
and paint back in areas hidden by the masking bugs.

TIP: To see the mask created by the Masking Bug, and the range of black to
white tonality, choose Show Mask from the View menu. You can choose either
a red overlay, which presents the mask over your image, or grayscale, which just
shows the mask as black to white tones.
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QUICK MASK Al BRUSH

The Quick Mask Al brush is an Al-based selection tool that automatically selects regions in

a photo when you hover over them with your cursor. It intended to create selections for the

current layer in your document. In this way, you can apply noise-reduction, sharpening or

deblurring operations to specific areas in a photo. As with all of the masking tools, you should
have at least two layers in your document; if you have only a single layer, the masking operation will remove
the masked pixels from your photo.

To use the Quick Mask brush, first duplicate your layer, select the tool, and move your cursor over the
photo. As you move around the photo, NoNoise Al will display the various regions in your photo as red
overlays; clicking on a region will create a selection and change the overlay for that area from red to blue.
If there are additional regions you wish to select, hover over the new area and click. To remove a selection,
click on it a second time.

The Quick Mask Al Options bar has two options: Paint or Erase. Paint will apply the final adjustment to the
selection you created with the tool, while Erase will apply the adjustment to the areas to the inverse of the
selection (i.e. the areas that have not been selected). Clicking the checkmark button will create the mask
and select the Refine Brush so you can fine-tune the mask.

While the masks created by the Quick Mask tool are generated automatically, they function like any other
mask created in NoNoise Al. This means you can use the other masking tools to adjust and refine the
finished masks. This also includes the Mask Control options found in the Masking tab of the Properties
window (see “Masking Basics” on page 70 and “Masking control options” on page 71).

Quick Mask Al Brush Options bar

Paint Erase °

e Mode Selector: Paint means that the mask will be applied to the selection; Erase means that
the adjustment or filter will be applied to all areas in a photo except for the selection.

e Cancel: Cancels the operation, deselecting the tool and selecting the Zoom tool.

e Done: Creates the mask and selects the Refine brush.

QUICK MASK BRUSH

Powered by machine learning, the Quick Mask brush creates high-quality masks with just a few

strokes. To use it, you paint areas you want to keep in green and areas you want to drop in red.

NoNoise Al analyses the color, tone and texture of the marked regions to learn what you want

to make out and then automatically finds the edges and creates the mask for you. Use it with
layers to replace skies or with filters to selectively apply them.

To use it on a layer, select the layer and follow these steps:

1. First, you need to give the tool guidance as to what you want to keep and drop. This is done
by loosely painting over the regions in your photo. There is no need to precisely paint the
entire photo: just a few representative strokes of red and green are all that are needed. Paint
with Drop mode—which is the default brushing mode—over the portions of your image that
you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to
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Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas
you want to keep. These strokes will show up as green.

2. Now press the Apply button in either the Tool Options bar or the Original Quick Mask HUD.
This will generate a temporary mask to preview the results. Areas that are filled with red will
be masked out, areas in green will remain. Keep in mind the edges will appear rough at this
point and will be smoothed out when you generate the final mask.

3. If the preview results look good, press the Done button in the Tool Options bar or the
Original Quick Mask HUD. If there are areas that are incorrect, you can continue to improve
the results by adding more Keep and Drop strokes. Press Apply each time to preview the
improved results. When you press Done, the edges are refined with high precision and
NoNoise switches to the Refine Mask tool.



Once you click on the Done button, NoNoise will create the finished mask (shown here as a red overlay), applied to the
current filter. You can manipulate the mask further with any of the refine mask tools.

Quick Mask Brush Options Bar

Keep Erase Size 800 v Ooo

¢ Mode Selector: Paint means that the mask will be applied to the selection; Erase means that
the adjustment or filter will be applied to all areas in a photo except for the selection.

e Brush Size: Controls the size of the brush. Use a small brush at high magnification for precise
work, and a large brush at fit to screen for general work.

Further settings for the Quick Mask brush can be found by clicking on the gear icon in the Tool Options bar.
There, you can set the following options (shown right):

e Pressure Adjusts Size: This option lets you control the size of the brush using a pressure
sensitive tablet. The harder you press, the larger the brush becomes up to the current setting
of the size slider.

o Refine Edge: Applies the Refine Mask brush Al QUICK MASK
automatically to the edge of the resulting mask, Use the red Drop mode to mark the area(s) you
. . . want to paint-out. Then use the green Keep mode
creajcmg a more natural transition. This the default TS 0 T [P e o
and is recommended for most photos. to preview the mask. You can continue painting
L . , red or green until the desired mask is reached.
 Show HUD: This displays the Quick Mask Brush's Then press Done or switch tools to create the final
HUD dialog, which provides guidance on how to mask. The edges will be automatically refined
use the tool. when you do.

Do not show Apply

o Overlay: Sets the transparency of the red and green
The Quick Mask Brush HUD gives displays instructions for

mask (_)Verlays on tOp of your image. A s?ttlng of using the tool. You can turn the HUD off via the Gear menu
100 displays only the mask; the default is 50. in the tool options bar.
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LINE MASK TOOL

The Line Mask tool lets you create masks by

drawing straight lines in your image, with the

added flexibility of letting you adjust each

individual line segment into curves to better
fit the object you want to mask. Masks created with this
tool are re-editable, can be copied and pasted like any
other mask inside NoNoise, and you can have multiple
Line Mask selections for each mask.

To start, you click and drag along the outline of the area
you wish to mask. Clicking your mouse button (or with a
pen and tablet) adds a point to the line; you can continue
to click along the edges of your desired selection, and
the tool will add points along the way. These points will
be represented by a small square. When you're finished,
hover your cursor over the first point and click on it to - -
close the path created by the tool. This will close the Dot Vs caramr il home o it buekes oom. it n the
selection and change the cursor to a paint bucket icon; area will generate the mask..

click inside the area and NoNoise will create and the display the mask.

Once you've closed the mask, you can adjust the feather and opacity of the mask, and you can further
adjust the points on the line in the following ways:

¢ You can click on any point in the selection and move it by dragging it.

e If you hover (or click) on a point, you'll see a circle appear between that point and the
previous point on the line. This circle can be dragged in all directions to curve the line to
better fit the object you are masking.

e Add a point by holding down the Shift key and clicking on the line.
e You can delete any point by right-clicking on it and choosing Delete Point from the pop-up.

e You can delete the entire mask by choosing Delete Line Mask from the pop-up menu.

While you're creating the mask, the curve option is always available for the current point; move the cursor
back over the line before the point and the circle will appear. You can then drag the curve in or out, and
when you're done, move the cursor and click on the next place you wish to add a point.

When you've made your adjustments to the selection, you can click the Done button in the Tool Options
bar to quit the tool, or you can create another mask.

To re-edit the mask at a later time, select the filter, layer,
or adjustment layer that has the mask attached to it and
choose the Line Mask tool. When you move your cursor
over the area that contains the mask, the mask’s outline
will appear in light blue. Click anywhere on the outline,
and the mask’s points — both square and circle — will
appear, and you can adjust it as you see fit, even the
Opacity and Feather settings.

The curve option—visible when you hover over a point in the
selection—lets you fine tune the line to make it better fit the
object you're masking. (Shown here exaggerated for effect.)
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Line Mask Tool Options Bar

Paint Erase Opacity 100 v Feather 0 v

Mode Selector: Paint means that the mask will be applied to the selection; Erase means that
the adjustment or filter will be applied to all areas in a photo except for the selection.

Opacity: Controls the opacity, or transparency of the finished mask, from 1 to 100 percent.
At 100 percent, all of the effect will be displayed in the mask area; as the opacity level drops,
more of the layer underneath the mask will be visible.

Feather: Controls the hardness of the mask edge. The feather has a range from 1 to 100;
1 being a hard edge across the boundaries of the mask, 100 being a soft, wide edge that
‘feathers’ the transition between the masked and unmasked boundaries.

Delete: Removes the currently selected line mask.

Done: Saves the current line masks ad closes the tool, returning NoNoise Al to the View Tool.

REFINE BRUSH

This tool can be used to clean up intricate areas and the borders along a mask. It is helpful
for cleaning up a mask created with the Masking Brush, the Quick Mask Al brush, or other
masking tools, or for creating a new mask entirely.

When you paint with the Refine Brush, the brush strokes are displayed as a red overlay, and when you let
up off the mouse button, NoNoise will work to give the mask edge better definition.

Refine Brush Tool Options

Mode

Paint Out v Size 150 v Method Hair/Branches v {3

Mode: Controls the refinement mode, either Paint Out, which refines to remove from the
mask, Paint In, which refines to add to the mask, or Auto, which determines the best way to
refine the mask edge. Paint Out is recommended in most cases.

Size: This adjusts the size of the brush. Select a brush size that is just larger than the
intersection of the subject and background. Avoid using oversized brushes it will take longer
to process and may vyield lower quality results. You can use your mouse’s scroll wheel to
adjust the size of the brush as well (see “Using NoNoise with a Scroll Wheel” on page 20).
The Refine Brush’s maximum size is 500 pixels.

Method: Lets you choose the refinement algorithm and settings

Original
based on the subject of the masked area. There are five method . h
types, plus a user-defined setting that is created when you adjust Hair/Branches
any of the individual parameters found in the Gear menu: Hard Edges
e Original: Uses the refinement algorithm found in earlier Diffuse Edges
versions (referred to as Mode 1 in the gear menu). Noisy Images
¢ Hair/Branches: Optimized for fine detail, like hair, branches User Defined

and other subjects. The Method pop-up.
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e Hard Edges: Best method for refining masks with distinct edges between masked and
unmasked areas.

o Diffuse Edges: Works best on areas where edge detail is not as well-defined.

¢ Noisy Images: Works well on photos that have higher degrees of noise in them.

The Gear menu includes a setting for controlling the size of the Refine Brush with pressure. It also can be
used to adjust any of the refine methods in the Method menu. The parameters include:

e Mode (1 or 2): As noted above, Mode 1 is the Refine Brush
algorithm used in previous NoNoise versions; it remains useful in
many masking situations. Mode 2 uses the new (2023) version of

Pressure Adjusts Size

the Refine algorithm. Mode 2
—

e Sensitivity (0-100): Refers to the edge sensitivity; low for diffuse

edges, high for hard edges. (Works only with Mode 2) Sensitivity 0

. . . . ®

e Locality (0-30): This parameter varies the search for similar scene

materials; higher values expand the search zone along the brush Locality

edges. (Mode 2 only) —
e Smoothness (0-100): Represents post-processing smoothing of Smoothness

the refine results. Higher numbers mean smoother edges. (Mode 2 B —— ]

only)

¢ Noise (0-100): This is a post-processing-based noise filter; use ®
higher values with noisier images. (Works with both Mode 1 and 2)

When you change any of the parameters in the Gear menu, those results will be applied to the User
Defined settings, and will be saved until you change them again. In general, however, most of your masking
refinement work with the Refine Brush should be found in one of the five primary Method options.

Working with the Refine Brush

One of the biggest issues with masks is the transitions between edges, or in areas where one of the
primary masking tools will miss some fine detail. You'll notice these transitions when you apply an effect or
adjustment to a masked area, and there will be halos on the mask edges, or areas where the effect should
be applied, but isn’'t. The Refine Brush, and, on occasion, the Chisel and Blur tools, can be used to help you
fine-tune your masks and better transitions, ultimately creating more realistic masks.

The Refine Brush is often the first place you'll want to go when working with masks that could use some
tuning. Some of the most common operations include:

¢ You can paint along the edges of a mask that might have areas where the mask isn't complete,
or where the transitions between masked and unmasked areas could be smoother.

e You can paint over large areas of a masked area where there might be fine edges that could
use further refinement, like trees or hair.

e You can also “encircle” an area in a photo where you wish to add to or subtract from a mask,
or even create a new mask altogether.

For simple areas where you wish to refine an edge that has some halos or is otherwise a bit less than ideal,
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set the brush size a bit larger than the area you wish to tune set the appropriate method, and brush over
the edge. This is shown in the enlarged area below.

In the photo above, a local adjustment on the sky, masked with Mask Al, left some ugly halos along a treeline. Using the Refine Brush, set to the
Diffuse Edges method, smoothed the transition properly, making for a better mask. (Effect exaggerated for demonstration purposes.)

With tree branches, hair and other areas of fine detail, you can paint over the entire area that you wish the
mask to refine, as shown in the following graphic.

The Refine Brush is a great choice for adjusting masks with fine details that are often obscured when building masks with some of the primary
masking tools. In the screen shots above, you can see the mask of a tree generated automatically with the Mask Al pop-up in a local adjustment
layer (left). The tree’s interior branches are completely masked. Selecting the Refine Brush, with the Method set to Hair/Branches, we've painted
broad strokes in and around the area where the branches are (center). NoNoise then refines the mask so that the branches are properly masked
against the sky, making for a much more realistic mask.

The Refine Brush’s “encircling method” lets you add to or subtract from an existing mask, or you can use it
to create your own mask. To do this, use the brush to draw an outline
around the object you wish to select and mask. What happens next
depends upon what your intent is, and whether there is already a mask in
the local adjustment or Effects filter you are currently working with:

e If there is a mask already created, and you wish to remove the
stroked area, choose Paint Out before applying the brush. If you
wish to add to the existing mask, choose Paint In.

e |If there is no mask already present in the adjustment or filter,
using the Refine Brush and drawing around an object or area
will create a mask of the encircled space.

For more information about masking inside NoNoise, see “Masking Basics”
on page 70.

The encircling method.
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CHISEL BRUSH

The Chisel brush works to remove fringes or halos along the hard edges of a mask; just

click and drag along the edges of a mask you wish to refine. Fringes are common when the

background to be removed is brighter than the foreground. The chisel works like a chisel or

plane in a wood shop: It removes just a sliver along the edges, and, because it only works on
the edges, you don't have to be too careful when using it.

Chisel Brush Options

Add Remove Size 20 v Amount 10 v

e Mode: Select remove or add from the mask edge

e Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast.
The size of the chisel does not affect how much is chiseled off.

e Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-clicking on the Chisel icon applies the chisel to the entire mask.

BLUR BRUSH

The Blur brush softens edges of the mask where you paint; all you need to do is run the tool
over the edges you wish to blur. Softening the edges on blurred or semi-transparent subjects
like hair can make them blend with a new background in a more realistic manner.

Blur Brush Options
Mode Normal v Size 50 v Amount 30 v

¢ Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs
and lightens the mask, Add blurs and darkens the mask, Normal blurs both light and darks.

e Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The
size of the brush does not affect the blur amount.

e Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-clicking on the Blur icon applies the blur to the entire mask.
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Masking Basics

Every layer in NoNoise Al can have a mask associated with it, letting you apply different noise reduction
and sharpening settings on a layer-by-layer basis.

At its simplest level, a mask shows or hides the pixels on a layer. Masks have no color: they are grayscale,
and the tones range from pure white to pure black. A mask that is completely white displays the entirety of
the layer’s pixels, a mask that is completely black hides those pixels, and the pixels from the layer beneath
it show through instead. (A common way to remember it is via the phrase “black conceals, white reveals.”)

Shades of gray are in effect the opacity of the mask. Darker shades reduce the effect, lighter shades let
more of it through.

The beauty of the masks is that you can paint with black, white or any shade in between, so you can “mask”
portions of your photo so that they will not have that effect—or will have a reduced effect. You can also
copy masks from one layer and paste them into another. You can view your masks, either as a red overlay or

as the grayscale version of the actual mask, which can be helpful when you wish to look at the edges of
mask.

The two options for viewing a mask are with a red overlay (left), which shows the masked areas in red, and a grayscale mask (right), which shows only the mask, in a
range of tones from white (not masked) to black (completely masked). Tones in gray represent varying percentages of the mask’s opacity.

Creating masks can be as simple as using the Mask Al pop-up in the Masking Control Options—or the Al
Quick Mask tool—to select an area of a photo automatically. You can also use the Original Quick Mask to

pick areas of a photo to be selected, or you can use using multiple tools and masking functions to generate
precise selections.

THE MASKING TOOLS AND VIEW OPTIONS

Inside ON1 NoNoise Al 2024, there are five tools used to create masks: the Masking Brush, the Gradient
Mask, the Quick Mask Al Brush, the Quick Mask Brush and the Line Mask tool. The Quick Mask Al
Brush—along with the Mask Al tool the Masking Control Options section (see page 71)—generate masks
automatically, based on known regions in your photos.

You can use the Masking Brush, Masking Bug and Line Mask tool cumulatively, meaning that you can add
to or subtract from the current mask. However, if you select the Quick Mask Al or Original Quick Mask
brushes, they will replace any existing masks on that pane or layer.
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The Refine group of tools—Blur, Chisel and Refine—are designed to help work with edges and halos that can
crop up when you have areas of strong contrast between a masked area and an unmasked one.

When you add a layer, the mask is technically hidden. You can create a mask by either using one of the
masking tools, or by clicking the Show/Hide Mask icon in the layer, to the left of the layer name. The
contents of the Show Mask icon will represent the mask on that layer.

NoNoise has two primary options for viewing the contents of a mask: either as a red overlay on top of
your image (the default) or a view only of the mask itself, represented as grayscale. You can turn the mask
overlay on and off by pressing the ‘O’ key on your keyboard.

The grayscale view can be helpful when checking edges, or when refining some of the advanced masking
controls. These mask view options are available from the Mask menu; select Show Mask to see the mask,
while the View Mode option lets you switch between the two modes. You can also only display the red
overlay when you are brushing with the Masking Brush. (NoNoise will remember the previous settings.)

When you're viewing a mask in either overlay or grayscale modes, you have access to all of the tools in
NoNoise Al. You can zoom in, to view the mask in greater detail, you can use the Refine masking tools to
adjust the fine edges of your mask, or you can use any of the other the masking options described below.

MASKING CONTROL OPTIONS

Properties
When you click on the Mask icon at the top of a pane or in a layer,
NoNoise will open the Masking tab of the Properties window (see
page 73), which displays a set of options for that specific mask. This
section has the following contents, as shown:

Blending Masking

Mask Al Region Architecture v

Density

A. Mask Al pop-up (Effects and Local tabs only) for selecting  E—
an area based on region. F.eamer

B. The Global Settings section includes the following mask L.”e’s

options: Density adjusts the overall density from black (100) Window

to white (0); Feather blurs the mask; Levels and Window ®

let you adjust the black and white points of the mask, fine

tuning them in different ways.

C. The Color Range option lets you choose a color and make or
tune the mask based on the range of the color selected.

D. View of the current mask, with options (from left to right) to
invert the mask, create a luminosity mask, reset the mask,
copy and paste the mask, and view or hide the mask overlay.

E. The Mask Al pop-up, which displays the regions in the
current photo. You can select multiple regions, and choose e
whether to have the mask painted in or out when applied. Foreground
Once you select a region, click Apply to create the mask.

None

Architecture

. . Sky
The buttons at the bottom portion of the Masking tab can be helpful
when you’re working with complex masks: Fle
Paint In
¢ Invert reverses the contents of the mask, swapping the Cancel Apply
tones.
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e The Reset button erases the current mask, leaving it filled with white.

e The Copy and Paste buttons let you copy the current mask, to paste it into another filter,
local adjustment or layer.

e The View button toggles the Mask View on and off.

e The Lumen button creates a luminosity mask of the image, which is a mask based solely on
the brightness of each pixel in a photo. Darker tones will have a reduced effect of the current
layer’s settings, while lighter ones will let more of the effect through.

Color Range selections

The Color Range option lets you create a mask using a specific color, either one inside your image, or one
via your system’s color picker. To use this option, click the On button next to the Color Range section, and
click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the
slider to expand or contract your mask based on that color: lower numbers means that fewer colors (related
to the chosen color) will be selected, higher numbers mean a wider range of colors will be selected.

The Color Range option found in the Gradient masking tools can be controlled from the Mask Options
section of the pane. When you add a gradient mask and click on the Color Range option in the Tool Options
bar, the color chosen is sampled from the center of the gradient control, but you can open the Mask
Options pane and sample a different color using the eyedropper. Note that if you do this, and move the
masking bug, it will resample using the color from the center of the bug. The Color Range option found in
the Masking Bug'’s Tool Options bar can be controlled from the Mask Options section of the pane. When
you add a gradient mask and click on the Color Range option in the Tool Options bar, the color chosen is
sampled from the center of the gradient control, but you can open the Mask Options pane and sample a
different color using the eyedropper. Note that if you do this, and move the masking bug, it will resample
using the color from the center of the bug.

MASKING TIPS

Here are a few tips for working with the various options in the Mask pane:

¢ While the Al-based masking tools can be quite good when building selections, they aren’t
perfect. You should inspect your Al masks after applying them, and use the other masking
tools, the refine mask tools or Mask Options to fine-tune your selections.

e Use the Feather slider to smooth transitions between masked and unmasked sections.

¢ Lowering the Density slider helps intensify an effect after you've created a mask. Think of it
like a ‘reverse fade’: at the 100, all of your mask is viewable, at O, the mask is entirely white.
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The Properties Window

The Properties window is used for setting blending modes and masking options when working with Layers.
By default it is configured to act as a pop-up window, but it can also be configured to act as a pane in
NoNoise’s right-side panel.

Properties Properties

Blending Masking Blending Masking

Blend Normal v Opacity 100 v Mask Al  Region Al v

Density
———————————————————————

Feather

ColorRange All v

Range

—

Highlights
®

Shadows

Window

Color Range

The Properties window is closed by default, but opens when you
click on the blend mode icon or when you create or click on a mask. v Levels [INICR Fistoy  Snapshots
For information on using the blending modes, see page 74; o
masking options are detailed on page 71.

CONFIGURING THE PROPERTIES WINDOW S

Blend Normal Opacity 100 v

You can configure the Properties window’s visibility in a number of
ways, via the Windows > Properties submenu:

ColorRange All v

e The Show submenu option turns the pop-up window (or Range
nested pane) on or off. When set to off, the pane will be - °
hidden, but will reappear once a masking tool has been
selected.

Highlights
®

Shadows

e The Nest submenu option relocates the Properties
window to a pane in the left side of the window, above

the Layers pane.
Layers
e The Auto Collapse option collapses either the window

or pane to just the tab headings (Blending, Mask, Text).
Positioning your mouse over any of the tabs displays the
entire pane.

Blend Normal v Opacity 100 v
s O selective shadow noise
‘W O ISO_samples_20141030_0097.arw

Properties can also be nested within the
right panel.
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Blending Modes

In addition to opacity, you have one other very powerful option for adjusting the strength and effect of a
layer: blending modes. Blend modes determine how a layer interacts with the layers below it in the image
stack. Blend modes can darken or lighten an image, depending upon the mode chosen, while others adjust
contrast or color. NoNoise Al’'s blend modes also let you apply a blend mode to specific colors or tones in
your image, making them a very useful tool for precision editing of your images. You can apply sharpening,
for example, only to the midtones in an image, which can be very helpful in a landscape image.

The basic blending modes are available at the top of the Layers pane, but if you want additional control,
open the Properties window, where you will find the following options.

¢ Blending Options: A pop-up list of blending modes. There
are 24 common blending modes available in the list, including
Normal, Lighten, Darken, Screen, Multiply, Soft Light, Hard

Light, Overlay and Color.

e Apply To: This lets you apply the blending mode to a specific
color or tonal range. The options are; All (the default),
Highlights, Midtones, Shadows, Reds, Greens, Blues,
Magentas, Cyans, Yellows, Flesh Colors, Vivid Colors and
Neutrals. (You can also manually choose a color range by
selecting the Dropper Tool in the pane and clicking on a color

in your image.)

o The Protect sliders help protect highlight, and shadow areas
and skin tones from the application of the blending mode.

When you choose one of the options in this menu, the adjustment is

Blend Normal v

Range

—

Properties

Blending Masking

Opacity 100 v

ColorRange All v

Highlights

Shadows

only applied to that part of the image that is based on the lightness, hue, or saturation range specified. The
Range slider expands or contracts the selected option, and the Highlights, Shadows, and Skin sliders protect

those settings from your adjustments.

How blending modes work

At their basic level, blend modes determine how the
pixels on one layer interact with the layers below

it. With 24 blend modes in NoNoise Al, it might be
difficult to know which ones to use in any given
situation, but they can easily be grouped into Normal
(the default mode) and five categories: Darken,

Lighten, Contrast, Comparison, and Color/Luminosity.

Normal is the most widely used: it simply applies the
effect to all of the pixels in the adjustment (or effect),
assuming the layer opacity is 100%.

The other modes apply different levels of that
category’s effect using various mathematical
formulas, and sometimes it can be hard to know

ON1NONOISE Al BLEND MODES

DARKENS

LIGHTENS

ADDS CONTRAST

ADJUSTS BASED ON COMPARISON

AFFECTS COLOR OR BRIGHTNESS

Normal

Multiply
Color Burn
Linear Burn
Darker Color

Lighten

Screen

Color Dodge
Linear Dodge (Add)
Lighter Color

Overlay

Soft Light
Hard Light
Vivid Light
Linear Light
Pin Light
Hard Mix

Difference

Exclusion

Hue
Saturation
Color
Luminosity
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which mode will work best with what photo. Most often, when you know how you want to apply an effect
—by darkening, for example—you'll need to perform a bit of experimentation with the different modes in
that category to determine which mode works best.

ONI1 NoNoise Al 2024 User Guide Part 4: Working with Layers 75



PART 5:
ON1 NONOISE Al 2024 REFERENCE

MENUS AND PREFERENCES



Menus

ONT1 NoNoise Al (MacOS Only]

About ON1 NoNoise Al: Opens the About box and displays
your version number. (This is in the Help menu on Windows)

Preferences: Opens the preferences dialog. (In the Edit menu
on Windows)

Quit ON1 NoNoise Al: Quits ON1 NoNoise Al 2024.

File Menu

Done: Finishes the processing in the current window.
Cancel: Cancels the current job.

Quick Export: Saves the current image in Photoshop, TIFF,
JPEG or PNG format.

Export: Opens the export side panel.

Export with Previous: Exports the current job automatically,
using the last export settings.

Manage Extras: Opens the Extras Manager (for importing and
managing custom brush shapes and watermark files)

Edit Menu

Undo: Removes the last file operation.

Redo: Redoes the undo operation. This is only available if the
last thing you did was an undo.

Cut: Cuts the currently selected item.
Copy: Copies the currently selected item.

Paste: Pastes (copies) the items in the clipboard to the current
location.

Revert: Reverts to the original state of the current photo.

Keyboard Shortcuts: Lets you modify the keyboard shortcuts
used by ON1 NoNoise Al.

Preferences (Windows): Opens the Preferences dialog.

About ON1 NoNoise Al 2024
Preferences...
Services

Hide ON1 NoNoise Al 2024
Hide Others
Show All

Quit ON1 NoNoise Al 2024

Done

Cancel

Quick Export...
Save As...

Export...

Manage Extras...

Undo

Paste
Revert
Keyboard Shortcuts...

Start Dictation...

Emoji & Symbols
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Layer Menu

e Delete: Deletes the currently selected layer.

. . Delete
e Duplicate: Duplicates the currently selected layer.

. Duplicate
e Reset Layer Properties: Removes any applied layer masks or

transforms to the current layer. Reset Layer Properties

e Merge Layer: Merges the current layer with the one beneath Merge Layer
it. .~

Merge Visible

e Merge Visible: Merges all of the visible layers into a new,

merged layer. New Stamped Layer

e New Stamped Layer: Merges the visible layers into a new, Align Visible Layers
composite layer, leaving the visible layers intact.

e Align Visible Layers: Aligns visible layers based on their

content.
Photo Menu
¢ Rotate 90 Degrees CW: Rotates an image clockwise by 90° Rotate 90° CW
¢ Rotate 90 Degrees CCW: Rotates an image counterclockwise Rotate 90° CCW
by 90°
Mask Menu
¢ Invert Mask: Inverts the mask, what was hidden is revealed Invert Mask
and vice versa. Reset Mask
e Reset Mask: Resets the mask to plain white.
e Copy Mask: Copies the mask. Copy Mask
e Paste Mask: Pastes the mask. Paste Mask
¢ Create Luminosity Mask: Creates a luminosity layer mask Create Luminosity Mask
based off of a photo’s black or white tonal values.
e Show Mask: Displays the current mask either as a red overlay Show Mask
or as grayscale. View Mode

¢ View Mode: Sets the Show Mask mode to either red overlay
or grayscale.
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Settings Menu

e Reset All Settings: Resets all of NoNoise’s settings on a photo.

e Reset NoNoise Al Settings: Resets any changes made to the
Details pane and returns the image to its original state.

¢ Reset All Retouching Tools: Resets retouching applied in Edit.
e Reset Crop: Resets any cropping made to a photo.

e Sync Settings: When multiple images are being processed, will
open the Apply Settings window to sync the settings from the
base image to the other images in the selection.

e Sync All Settings: When multiple images are being processed,
applies all of the base image’s settings to the other images in
the selection.

e Save Settings: Saves the current state of your edits, in case of
crash.

View Menu

e Zoom In: Zooms the preview window in one increment. This
will make the preview image larger.

e Zoom Out: Zooms the preview window out one increment.
This will make the preview images smaller.

o Fit to Screen: This sets the preview image so that the entire
image is on screen at once. Think of this as an overview of the
entire image. This is the setting you will use most of the time.

e Actual Pixels: This sets the preview image so that it zooms to
actual pixels or 1:1 also called 100%. This setting allows you
to see every pixel in the image. This is useful when making
precision adjustments.

e Show Clipping: Shows the clipping overlay view, displaying the
pure white or black pixels in the current image.

e Show Focus Mask: Displays a green overlay on those portions
of the current image that are in focus.

e Compare: Displays an adjustable split-screen view of the
current image, with the Before view on the left side of the
preview area.

¢ View Mode: When multiple images are being processed,
alternates between detail view and filmstrip view.

e Preview Background Color: Lets you set the background color
options.

e Auto Hide Tool Options Bar: When checked, the Tool Options
bar for each tool will be hidden on-screen, and becomes
visible when you hover over the top of the main window.

Reset All Settings
Reset All Retouching Tools
Reset Crop

Sync Settings...
Sync All Settings

Save Settings

Zoom In
Zoom Out
Fit To Screen
Actual Pixels

Show Clipping
Show Focus Mask

Compare
View Mode
Preview Background Color

Auto Hide Tool Option Bar
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Window

Help

Minimize: Minimizes your screen.
Zoom: Zooms your window to full-size.
Full Screen: Toggles full-screen mode (hides menus).

Navigator: Hides or shows the Navigator, Loupe, Histogram
and Info pane.

Solo Mode: Keeps only one pane open at a time.
Show Layers: Completely hides/shows the Layers pane.

Show Bumper Labels: Hides/reveals the text labels in the
module selector.

Show Control Panel: Hides/shows the right Control Panel.
Hide Panels: Hides or shows all Panels.

Show Right Bumper: Hides/reveals the right bumper, which
contains the Export icon.

Document Name: Shows the name, zoom level and bit depth
of the open image.

Search: Searches the menu options (MacQOS only).

Learning Hub: Opens the Learning Hub inside ON1 NoNoise
Al.

ON1 NoNoise Al 2024 Online Help: Opens ON1.com support
page in your default web browser.

Video Tutorials: Opens ON1.com product training page in
your default web browser.

Getting Started: Opens the initial NoNoise startup screens.

Check for Updates: Checks with the ON1 update server to
see if you are running the current version. If there is a newer
version, you will be notified and be walked through the
update process.

Sign-In/Sign-Out: Uses your ON1 account login information
to authenticate your copy of ON1 NoNoise Al 2024.

Provide Feedback: Opens the default web browser and goes
to the feedback page of the ON1 website.

About ON1 NoNoise Al (Windows Only): Opens the about
box with the version number displayed.

Help Improve ON1 Products: Opens the Improve ON1
Products dialog.

Show ONL1 Log: Diagnostic tool that can help ON1 support
when you're having issues with ON1 NoNoise Al 2024.

Minimize
Zoom
Full Screen

v Solo Mode

v Show Layers
Properties
Show Bumper Labels
v Show Control Panel
Hide Panels
Show Right Bumper

DeathValley.arw @ 100% 16-bit

Learning Hub...

ON1 NoNoise Al 2024 Online Help...

Video Tutorials

Check for Updates
Sign-Out...

Provide Feedback...

Help Improve ON1 Products...
Show ON1 Log
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Preferences

NoNoise has a number of system-wide settings that you can set via the Preferences window. To access
Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences from
the ON1 NoNoise Al 2024 menu (MacOS) or the Edit menu in Windows. The Preferences window has four
tabs—General, Files, Plugins, System—and are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings for

the NoNoise workspace, including background color,
scrolling controls, accent color, language and the default
noise-reduction settings.

Preferences

General Files

Plug-ins

System

Font Size Small v

Font Size
Preview Background Color Custom... v
Sets the size of the text in the basic NoNoise Al

workspace (labels, panes and pop-up menus) to one
of three general sizes: Small, Medium, Large. When
changing the font size, you must quit and restart
NoNoise Al for the new setting to take effect.

Accent Color u
Blue Orange Green Red Purple

Application Language Auto v

) Check for Update on Launch
Preview Background Color
Only Adjust Brush Size with Scroll Wheel

You may select the color of the background behind

the preview image. The default color is black. There

is options for black, white, light gray, dark gray and
custom. The custom option has a color picker where you
can select your own background color.

Accent Color

NoNoise Al Default High v

Enable Split Screen Compare when in Noise Al

(0].¢

Lets you choose the display color for highlighted items in the NoNoise interface.

Application Language

Lets you change the display language for NoNoise Al. Auto will use your system’s default language.

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1
Photo; if an update is available it will prompt you to download or skip.

Only Adjust Brush Size with Scroll Wheel

Turning on this option overrides NoNoise Al’s default behavior, setting the app so that your mouse’s scroll
wheel will only change the size of a brush (when an appropriate tool is selected).
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When not checked, NoNoise uses the scroll wheel to scroll, zoom, pan and adjust brush size and feathering,
depending upon the modifier keys being pressed. See page 20 for specifics on the default settings for
scroll wheel options in NoNoise Al.

NoNoise Al Default

Adjusts the strength of NoNoise Al’s default noise-reduction settings. (See page 24.)

Enable Split Screen Compare when in NoNoise Al

Lets you set the default option for working in the NoNoise panel when opening an image. When checked,
NoNoise will automatically switch to before/after Compare mode when you open a new photo. When
unchecked, you must click on the Compare button at the bottom of the screen to turn on the before/after
view.

FILES

Sidecar Options

Preferences
Click this box if you wish NoNoise to create
ON1-specific ‘sidecar’ files when you are editing General  Files Plugins  System
raw files in standalone mode. These files will Sidecar Options
contain any crop and retouching information
performed on the original, as well as Noise &
Sharpening pane details, and will reapply them if Default Processing
you reopen the file.

Save ON1 sidecar files for non-destructive edits and metadat:

Apply Lens Correction Automatically to Raw Photos

Disable Base Corrections on Raw Photos

Default Processing

Apply Lens Correction Automatically will use
lens correction information automatically on any
raw photo opened in ON1 NoNoise Al. Choosing Disable Base Corrections on Raw Files will turn off the
basic raw-file correction settings. This can be helpful for scientific/technical photography, time-lapse, and
other specialized applications.
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PLUG-INS

This tab is specific to using NoNoise as a plugin g Preferences

to Photoshop, Lightroom, and Apple Photos General  Files [ERERRE System

(maCOS). General

Ge n e ra | Leave "ON1 NoNoise Al 2024" Open when Done

Photoshop

Checking the “Leave ‘ON1 NoNoise Al 2024’
open when done” will keep the app open after
you've edited an image via a plugin.

Apply Results to Copy of the Current Layer v

Start with the Last Used Settings

Lightroom
File Type DNG (No Layers) v
Photoshop oty
Color Space Adobe RGB 1998 v
e Apply Results to: When editing in BitDepth  16-bit v

Photoshop you can choose to have your
effect added to a copy of your current
layer or to the current layer. You can also
choose to start with the last used settings
when launching NoNoise.

Resolution 300 pixels/inch
Stack with Original
Use Original for Single PSDs

Ask Every Time

ng hfroom Apple Photos

Enable Helper
This preference sets specific options for
files opened via the Plug-In Extras menu in

Lightroom:

e File Type: This determines what type of
file will be created. The default is DNG—the preferred format when processing raw files in NoNoise—
but you can also select PSD, JPG or TIFF, if you prefer those formats. One other option, Same as
Source, will edit the original file.

e Color Space: The color space menu determines which RGB working color space is used; Adobe RGB
1998, sRGB or ProPhoto RGB.

e Bit Depth: Sets the exported file's bit depth to either 8 or 16 bits per pixel.
e Resolution: Determines the resolution of the newly created file.

e Stack with Original: When enabled, the new image is stacked with the original image upon return to
Lightroom from NoNoise.

e Use Original for Single PSDs: When enabled, if you select a single image in PSD format, the original file
will be edited, rather than having a copy made.

e Ask Every Time: When checked, Lightroom will present these export copy options whenever you chose
an item from the Plug-In Extras submenu. Turning this option off will bypass the file-export window
inside Lightroom, using the options set in Plug-In Preferences window.

Apple Photos (MacOS only)

The Enable Helper option works to ensure a smooth connection between Apple Photos and NoNoise Al. It
should remain on by default.
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SYSTEM

Preferences

The System tab sets performance-related
characteristics of NoNoise 2021. General R Files BRItgin= S ESySTens

Al Processor

Al processor

Al Processor Auto v

Sets the processing option for NoNoise’s Al-
based operations. By default, the option is set

Memory Usage

System Usage

to Auto, which uses the best combination of - 0=
system resources to process tasks. If you are VRAM Usage: o
noticing some performance issues with NoNoise, —_—
you can try setting the options to either your Scratch Folder Location

CPU or your gra hiCS Card. /Users/rick/Library/Application Support/ON1/ON1 NoNoise Al 2023 Move.
y/ApP! PP!

Performance

Memory Usage

Video Card Strength e

Low

GPU Render
e System Usage: Specifies the amount of

RAM that is used by the application. The
maximum (default value) is 80%.

¢ VRAM Usage: Specifies the amount of video memory (VRAM) that is used by the application. The
maximum (default) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory cache, which helps speed editing operations while you're
running NoNoise. This is helpful if your system drive has limited space and wish to use a faster external
drive as a cache. This cache information is purged each time you quit the application.

Performance

The Performance section is designed to help you optimize NoNoise for your specific setup. The
adjustments you can make are as follows:

¢ Video Card Strength balances updating the preview of the image and the movement of brushes and
gradient tool overlays. If your brush is sticking try turning it down. If you have a high-end video card try
turning it up for faster preview updating.

e GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, sharing and
caching. This can greatly improve performance. It is on by default for systems that support it. It may be
disabled on lower-end GPUs.
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